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Nous  nous  efforçons  continuellement  d’améliorer  notre  documentation,  mais  personne  n’est  parfait.

•  Adobe  Acrobat  Reader  DC  (https://get.adobe.com/reader);

Pour  ouvrir  des  fichiers  PDF,  vous  pouvez  utiliser  n'importe  quel  visualiseur  PDF  gratuit,  par  exemple :

Les  images  de  couverture  utilisées  dans  le  manuel  sont  uniquement  à  titre  illustratif.

ACOM  n'est  en  aucun  cas  responsable  de  l'exactitude  de  la  documentation  non  anglaise.

Nous  vous  recommandons  vivement  d'utiliser  ce  manuel  au  format  électronique  (PDF)  plutôt  qu'en  version  imprimée.  Ce  fichier  PDF  est  

facile  à  lire  sur  ordinateur,  tablette,  smartphone  ou  autre  appareil  similaire.  Grâce  aux  liens  contextuels  (marqués  en  orange) ,  notamment  

la  table  des  matières,  vous  trouverez  rapidement  les  informations  nécessaires.

Les  traductions  dans  d'autres  langues  effectuées  par  nos  revendeurs,  partenaires,  distributeurs,  etc.  ne  peuvent  

en  aucun  cas  être  liées  à  la  société  ACOM.

Les  dernières  versions  de  nos  manuels  d'utilisation  sont  disponibles  sur

La  société  ACOM  crée  et  distribue  sa  documentation  en  langue  ANGLAISE  uniquement.

Lecteurs  PDF.

De  plus,  ce  manuel  d'utilisation  est  fourni  TEL  QUEL  et  ACOM  ne  sera  pas  responsable  des  éventuelles  erreurs  qu'il  contient.

Aidez­nous  en  envoyant  vos  suggestions  à  l'adresse  e­mail  suivante :

Dans  le  cadre  de  nos  efforts  constants  d'amélioration  et  de  mise  à  jour  de  nos  produits,  TOUS  LES  PRODUITS,  SPÉCIFICATIONS  ET  

DONNÉES  SONT  SUSCEPTIBLES  D'ÊTRE  MODIFIÉS.  ACOM  se  réserve  le  droit  d'apporter  des  modifications  et  des  améliorations  à  tout  

moment,  sans  préavis  ni  obligation  d'en  informer  quiconque,  afin  d'améliorer  la  fiabilité,  la  fonctionnalité,  la  qualité,  la  conception  et/ou  les  

performances  de  ses  produits  et  services.

Toute  la  documentation  ACOM  (y  compris  les  manuels,  brochures,  spécifications,  descriptions,  présentations,  supports  vidéo,  etc.)  est  
basée  sur  les  dernières  informations  disponibles  au  moment  de  la  création  de  nos  documents.

Avez­vous  trouvé  des  erreurs  ou  souhaitez­vous  suggérer  des  modifications  dans  notre  documentation ?

Foxit  Reader  (https://www.foxitsoftware.com/pdf­reader) ;

Et  notre  documentation  ne  fait  pas  exception  à  cette  règle.
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•

Ce  manuel  explique :

Installation

de  l'amplificateur  de  puissance  linéaire  à  semi­conducteurs  ACOM  1200S  1,8­54  MHz.

L'ACOM  1200S  est  un  amplificateur  de  puissance  linéaire  de  pointe  qui  couvre  toutes  les  bandes  amateurs  de  1,8  à

Nous  vous  invitons  à  lire  tous  les  documents  suivants  avant  de  commencer  à  utiliser  votre  nouvel  amplificateur.

1.1.  Introduction  et  description

ACOM  est  heureux  que  vous  ayez  choisi  l'un  de  nos  produits  et  nous  nous  efforcerons  de  vous  fournir  les  informations  et  l'assistance  dont  vous  

avez  besoin  pour  profiter  de  votre  achat  pendant  de  nombreuses  années.

Félicitations  pour  l’achat  de  l’un  des  meilleurs  amplificateurs  linéaires  à  semi­conducteurs  1,8­54  MHz  au  monde  aujourd’hui.

Il  est  cadencé  à  54  MHz  et  fournit  une  puissance  de  sortie  de  1 000  W  (PEP  ou  porteuse  continue)  avec  moins  de  50  W  de  puissance.  Les  

informations  de  fonctionnement  de  l'amplificateur  sont  affichées  sur  un  écran  couleur  multifonction  haute  résolution.  L'ACOM  1200S  peut  être  

contrôlé  soit  par  les  six  boutons  en  façade,  soit  à  distance.

Machine Translated by Google



Notes  d'information

Symboles  et  polices  utilisés  pour  marquer  le  texte

TEXTE  EN  GRAS  EN

LETTRES  MAJUSCULES

TEXTE  EN  MAJUSCULES

Format

Texte  en  gras  orange Identifie  tous  les  liens  internes  du  document  entre  les  sections,  les  figures,  les  tableaux,  etc.  pour  votre  commodité.

Signification

Identifie  les  modes  de  fonctionnement  de  l'amplificateur,  les  noms  des  menus,  les  messages,  etc.

Identifie  les  connecteurs,  les  commutateurs  et  les  noms  et  étiquettes  des  boutons.

COURRIER

Toute  personne  qui  utilisera  l'amplificateur  doit  lire  ce  manuel  et  suivre  les  instructions  qu'il  contient,  ainsi  que  les  autres  documents  
ACOM  qui  l'accompagnent  (voir  la  section  1.5  Documentation  supplémentaire),  et  prendre  également  en  compte  les  précautions  de  
sécurité  appropriées.

Le  symbole  d'information  met  en  évidence  les  procédures  ou  pratiques  d'exploitation  susceptibles  d'améliorer  
la  fiabilité  de  l'équipement  et/ou  les  performances  du  personnel,  ou  de  mettre  l'accent  sur  un  concept.

Le  symbole  du  livre  représente  une  référence  croisée  à  une  documentation  externe,  par  exemple  un  autre  
manuel  ACOM.

Dans  ce  manuel,  les  symboles  et  polices  suivants  sont  utilisés  pour  marquer  le  texte :

Pour  assurer  votre  sécurité  conformément  aux  normes  de  sécurité,  lisez  attentivement  ce  manuel  et  suivez  les  étapes  qui  y  sont  décrites.

Veuillez  respecter  les  informations  fournies  dans  ce  manuel  pour  garantir  un  fonctionnement  fiable  et  efficace  de  l'amplificateur.  Vous  y  
trouverez  les  informations  suivantes :

Ce  document  est  écrit  pour  les  utilisateurs  techniquement  qualifiés  qui  utiliseront  l'amplificateur  ACOM.

1.2.  Au  lecteur  de  ce  manuel

Page  10  sur  94  |  Section  INFORMATIONS  GÉNÉRALES

Manuel  d'utilisation  |  ACOM  1200S  |  Amplificateur  de  puissance  linéaire  1,8­54  MHz

Août  2024

Machine Translated by Google



Toutes  les  indications  d'état  de  l'amplificateur  sont  expliquées  via  un  texte  détaillé  affiché  sur  l'écran  couleur  haute  résolution  de  5  pouces  (108  x  

65  mm,  800  x  480  pixels  et  couleur  24  bits).

Compatible  avec  tous  les  modèles  d'émetteurs­récepteurs  ­  ne  nécessite  aucun  signal  spécial :  « masse  à  l'émission »  et  moins  de  50  W  de  

puissance  d'entraînement  RF  suffisent.

L'étage  PA  final  utilise  un  transistor  LDMOS  robuste  ­  BLF188XR  ou  équivalent.

Circuit  d'entrée  à  large  bande,  fournissant  une  charge  d'émetteur­récepteur  parfaite  avec  un  ROS  inférieur  à  1,2  (généralement  1,1),  sans  réaccord  

sur  toute  la  gamme  de  fréquences  de  1,8  à  54  MHz.

Le  fonctionnement  global  de  l'ACOM  1200S  est  extrêmement  simplifié :  les  menus  à  l'écran  sont  intuitifs  et  faciles  à  suivre,  aucune  compétence  

particulière  n'est  requise  de  la  part  de  l'opérateur  lors  du  changement  de  bande  de  fréquences.

Même  s'il  n'est  pas  connecté  au  CAT,  l'amplificateur  surveille  la  fréquence  du  signal  d'entrée  via  le  compteur  de  fréquence  intégré  et  change  

automatiquement  de  bande.

Lorsqu'il  est  connecté  à  un  émetteur­récepteur  avec  capacité  CAT,  l'amplificateur  suivra  la  fréquence  de  fonctionnement  et  changera  de  bande  en  

conséquence.

1.3.  Caractéristiques  du  produit

Des  données  détaillées  (55  paramètres)  sur  chacun  des  28  derniers  déclenchements  de  protection  contre  les  défauts  graves  sont  stockées  dans  

la  mémoire  de  l'amplificateur.

Il  s'auto­gère  pendant  le  fonctionnement  grâce  à  des  circuits  de  protection  fonctionnant  en  continu  dans  tous  les  modes.

L'opérateur  peut  surveiller  plus  de  10  paramètres  de  l'amplificateur  en  fonctionnement.

Contrôlé  à  distance  via  Internet  par  le  dispositif  de  télécommande  Ethernet  ACOM  eBox  (équipement  en  option)  et  via  un  port  RS­232.

Idéal  pour  les  expéditions  et  les  opérations  sur  le  terrain,  grâce  à  sa  conception  extrêmement  compacte  et  légère  et  à  son  alimentation  à  découpage  

(SMPS)  intégrée  fonctionnant  sur  une  plage  de  tension  secteur  étendue  de  100  à  240  VCA  (puissance  de  sortie  réduite  à  environ  500  W  PEP  en  

dessous  de  200  VCA),  sans  commutation  interne.  Le  courant  consommé  est  purement  sinusoïdal,  corrigé  du  facteur  de  puissance  (PFC)  et  limité  

en  appel  de  courant.  Cela  facilite  et  simplifie  le  fonctionnement  sur  des  réseaux  et  des  générateurs  instables.

Compatibilité  électromagnétique  (CEM)  parfaite  avec  les  appareils  hautement  sensibles  et  les  appareils  puissants  de  la  station  radio  (récepteurs,  

ordinateurs,  autres  amplificateurs)  dépassant  les  exigences  CEM  standard  grâce  au  PFC  utilisé  et  aux  filtres  radiofréquence  intégrés.

•  Technologie  de  transistor  LDMOS

•

•  Circuit  d'entrée  à  large  bande

•  Capacités  de  contrôle  à  distance

•

•  Indépendant  de  l'émetteur­récepteur

•
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•
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produit  jusqu'à  la  date  de  publication  de  ce  manuel.

Ce  manuel  est  valable  jusqu'à  ce  qu'un  nouveau  manuel  soit  publié.

Tableau  1­1  |  Historique  des  versions  de  production

Pour  plus  d'informations  importantes,  veuillez  vous  référer  à  la  documentation  suivante :

La  production  en  série  de  l'amplificateur  de  puissance  à  semi­conducteurs  ACOM  1200S  a  commencé  en  octobre  2017.  La  production  s'est  

poursuivie  jusqu'à  nos  jours  sans  modifications  fonctionnelles  et  avec  uniquement  des  améliorations  matérielles.

Tableau  1­1  |  Historique  des  versions  de  production

Ce  manuel  fait  référence  à  l'amplificateur  ACOM  1200S  et  décrit  les  possibilités  de  fonctionnement  de  tous  les  amplificateurs

1.4.  Historique  du  produit  et  validité  de  la  documentation

Numéro  de  série  ­  La  plupart  des  produits  possèdent  leur  propre  numéro  de  série.  Ce  numéro  est  un  numéro  consécutif  

permettant  d'identifier  de  manière  unique  les  produits  portant  la  même  désignation  de  modèle.  Il  permet  d'assurer  la  traçabilité  

d'un  produit  après  sa  mise  en  circulation,  par  exemple  pour  retrouver  la  date  de  facture  nécessaire  à  la  détermination  des  

périodes  de  garantie.  Le  terme  « numéro  de  série »  est  généralement  abrégé  en  « SN »  ou  « S/N ».

1.6.  Identification  du  produit

1.5.  Documentation  supplémentaire

Chaque  produit  ACOM  est  doté  d'une  étiquette/plaque  d'identification.  Cette  étiquette  se  trouve  généralement  au  dos  de  l'appareil.  Elle  contient  

les  données  d'identification  de  l'appareil.  Quelles  sont  les  données  d'identification  importantes ?

La  documentation  est  disponible  en  téléchargement  sur  www.acom­bg.com.

•
•  Désignation  du  modèle  ­  La  désignation  du  modèle  est  le  nom  de  l'appareil ;
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•  Brochure  ACOM  1200S;

Conception  de  base;

•  Informations  techniques  sur  les  câbles  ACOM  CAT ;
•  Manuel  d'utilisation  de  l'ACOM  04AT ;

Remarques

10.2017

Date  de  sortie
Version  de  production

•  Manuel  d'utilisation  de  l'ACOM  06AT ;
•  Manuel  d'utilisation  de  l'ACOM  eBox.
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1.7.  Équipement  fourni

L'amplificateur  ACOM  1200S  est  livré  sous  forme  de  package,  composé  de :

2  Câble  d'alimentation,  longueur  environ  1,8  m

Tableau  1­2  |  Contenu  du  colis

Figure  1­1  |  Étiquette/plaque  d'identification,  exemple

Tableau  1­2  |  Contenu  du  colis

Le  numéro  de  série  peut  également  être  vu  dans  le  menu  JOURNAL  DES  DÉFAUTS.

Figure  1­1  |  Étiquette/plaque  d'identification,  exemple

Le  manuel  de  l'utilisateur  est  disponible  uniquement  au  format  PDF.
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La  dernière  version  du  manuel  d'utilisation  est  disponible  sur  www.acom­bg.com.
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Pièces
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conçu  pour  fonctionner  avec  notre  série  d'amplificateurs  à  transistors  (à  semi­conducteurs),  y  compris  l'ACOM  
1200S  (voir  la  section  4.3  Fonctionnement  avec  un  tuner  d'antenne  externe).

Les  tuners  d'antenne  automatiques  ACOM  04AT  et  06AT  avec  commutateurs  d'antenne  à  quatre  voies  sont

L'utilisation  de  l'ACOM  06AT  ou  04AT  avec  un  amplificateur  ACOM  1200S  est  fortement  recommandée.

Figure  1­3  |  Tuner  et  commutateur  d'antenne  automatique  à  distance  ACOM  04AT

Tableau  1­3  |  Équipement  optionnel

Tableau  1­3  |  Équipement  optionnel

Plusieurs  options  d'achat  individuelles  sont  disponibles :

1.8.  Équipement  optionnel

Figure  1­2  |  Tuner  et  commutateur  d'antenne  automatique  ACOM  06AT

Figure  1­3  |  Tuner  et  commutateur  d'antenne  automatique  à  distance  ACOM  04AT

Figure  1­2  |  Tuner  et  commutateur  d'antenne  automatique  ACOM  06AT

Tuner  mural
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Accordeur  de  bureau

N°

2  ACOM  04AT  |  Tuner  et  commutateur  d'antenne  automatique  à  distance

1  ACOM  06AT  |  Tuner  et  commutateur  d'antenne  automatique

ÉQUIPEMENT  EN  OPTION

|  Dispositif  de  contrôle  à  distance  Ethernet3  ACOM  eBox  |
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1.9.  Assistance  au  propriétaire

Si  vous  avez  besoin  d'aide,  contactez  d'abord  votre  revendeur  local.  Si  nécessaire,  votre  revendeur  contactera  ACOM  pour  obtenir  
des  conseils  supplémentaires.

ACOM  Ltd.

Site  Web :  www.acom­bg.com  ­>  Page  d'assistance  E­
mail :  support@acom­bg.com

Figure  1­4  |  Télécommande  Ethernet  ACOM  eBox

Si  vous  avez  encore  un  problème  dont  vous  devez  discuter  avec  l'un  des  spécialistes  d'ACOM,  les  coordonnées  sont  les  suivantes :

Figure  1­4  |  Télécommande  Ethernet  ACOM  eBox

La  télécommande  de  l'ACOM  1200S  est  assurée  par  le  dispositif  de  télécommande  Ethernet  ACOM  eBox  
(voir  Section  6  TÉLÉCOMMANDE).

Il  est  obligatoire  d'inclure  le  nom  du  modèle  et  le  numéro  de  série  de  l'équipement  ACOM  ainsi  qu'une  
description  détaillée  du  problème  dans  votre  demande  d'assistance.  Sans  ces  informations,  nous  ne  pourrons  
pas  traiter  votre  demande  ou  la  procédure  sera  plus  longue.

Coordonnées  GPS :  42.748616о  |  23.209801о

Bulgarie  |  Bozhurishte  2227  Parc  
industriel  de  Sofia­Bozhurishte  |  6,  rue  Valéri  Petrov.
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Ce  manuel  d'utilisation  contient  des  informations,  des  avertissements  (mots­clés  Danger,  Avertissement,  Attention  et  Avis)  et  des  instructions,  

relatifs  aux  dangers,  qui  doivent  être  suivis  par  l'utilisateur  afin  de  garantir  un  fonctionnement  sûr  et  de  maintenir  l'amplificateur  dans  un  état  de  

fonctionnement  sûr  à  tout  moment.

Les  consignes  de  sécurité  contenues  dans  ce  manuel  d'utilisation  comportent  des  mots  d'avertissement  spécifiques  

(Danger,  Avertissement,  Attention  et  Avis)  et,  si  nécessaire,  un  symbole  d'alerte  de  sécurité,  conformément  aux  normes  
en  vigueur  ISO  3864  ou  ANSI  Z535.

Ces  notes  attirent  l’attention  sur  une  procédure  ou  des  instructions  qui,  si  elles  ne  sont  pas  correctement  exécutées,  

entraîneront  des  blessures  graves,  voire  la  mort.

Ces  notes  attirent  l’attention  sur  une  procédure  ou  des  instructions  qui,  si  elles  ne  sont  pas  correctement  exécutées,  

pourraient  entraîner  des  blessures  graves,  voire  la  mort.

L'amplificateur  est  conçu  pour  répondre  aux  normes  de  sécurité  internationales  et  est  conforme  aux  exigences  de  sécurité  et  de  compatibilité  

électromagnétique  CE,  ainsi  qu'aux  réglementations  FCC.

Les  DÉFINITIONS  EXPLICITES  décrites  ci­dessous  s'appliquent  à  ce  manuel  d'utilisation :

L'amplificateur  de  puissance  linéaire  ACOM  1200S  est  un  appareil  de  classe  de  sécurité  I  en  matière  de  protection  contre  les  chocs  électriques.  

Le  troisième  fil  de  terre  du  cordon  d'alimentation  (jaune  avec  deux  bandes  vertes)  et  la  borne  de  terre  située  à  l'arrière  de  l'amplificateur  (marquée  

GND,  voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (a))  doivent  être  connectés  au  système  de  mise  à  la  terre  de  la  station  pour  un  

fonctionnement  sûr.

1.10.  Considérations  de  sécurité,  définitions  explicites

Ces  notes  attirent  l’attention  sur  une  procédure  ou  des  instructions  qui,  si  elles  ne  sont  pas  correctement  exécutées,  

pourraient  entraîner  des  blessures  corporelles  mineures  ou  modérées.

mais  aussi  aux  équipements  connectés.

Ces  notes  attirent  l'attention  sur  une  procédure  ou  des  instructions  qui,  si  elles  ne  sont  pas  correctement  exécutées,  

pourraient  entraîner  des  dommages  matériels  ou  des  dommages  matériels,  pas  uniquement  à  l'amplificateur.
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La  tension  secteur  et  la  haute  tension  continue  jusqu'à  500  V  à  l'intérieur  de  l'amplificateur  ACOM  1200S  sont  

MORTELLES !

Pour  votre  sécurité,  débranchez  la  fiche  d'alimentation  de  l'amplificateur  de  la  prise  secteur  et  ATTENDEZ  AU  MOINS  3  

minutes  À  CHAQUE  FOIS  AVANT  de  retirer  le  couvercle  de  l'amplificateur.

Ne  laissez  personne,  et  surtout  pas  les  enfants,  insérer  quoi  que  ce  soit  dans  les  orifices  du  boîtier :  cela  pourrait  

provoquer  une  décharge  électrique.  NE  TOUCHEZ  JAMAIS  UNE  ANTENNE  ou  les  isolateurs  d'antenne  pendant  la  

transmission  ou  le  réglage :  cela  pourrait  provoquer  une  décharge  électrique  ou  des  brûlures.  N'EXPOSEZ  JAMAIS  

l'amplificateur  à  la  pluie,  à  la  neige  ou  à  tout  autre  liquide.  ÉVITEZ  de  placer  l'amplificateur  dans  un  environnement  

excessivement  poussiéreux  ou  en  plein  soleil.  N'OBSTRUEZ  PAS  les  conduits  de  refroidissement  ni  les  évents.  Maintenez  

une  distance  de  sécurité  minimale  de  10 cm  (4 pouces)  avec  tout  autre  appareil  ou  objet.

Figure  2­4  |  Panneau  arrière  ­  Connexions)  doivent  être  connectés  conformément  aux  normes  et  réglementations  locales  

en  vigueur  en  matière  de  sécurité  électrique,  de  sécurité  incendie  et  de  protection  contre  la  foudre,  dans  tous  les  cas  où  

la  station  radio  est  équipée  d'antenne(s)  extérieure(s) !

Pour  éviter  les  accidents,  la  connexion/déconnexion  à  la  terre  et  aux  antennes  ne  doit  être  effectuée  que  par  temps  clair,  

calme  et  ensoleillé,  lorsqu'il  n'y  a  aucun  risque  de  foudre  et  de  décharges  statiques.

Ne  sous­estimez  JAMAIS  le  danger  de  la  foudre !

Pour  un  fonctionnement  sûr,  la  borne  de  mise  à  la  terre  de  l'amplificateur  sur  le  panneau  arrière  (marquée  GND,  voir

consultez  votre  revendeur.

Si  vous  avez  des  doutes  sur  l'installation,  le  fonctionnement  ou  la  sécurité  de  l'amplificateur,  veuillez,

Pour  éviter  tout  dommage  (non  couvert  par  la  garantie),  lisez  attentivement  la  section  2  « INSTALLATION »  de  ce  manuel  

d'utilisation.  L'installation  de  l'équipement  doit  être  conforme  aux  réglementations  électriques  locales  et  nationales.
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N'entreprenez  aucune  réparation  ni  modification  matérielle  ou  logicielle  de  l'amplificateur  par  vos  propres  
moyens,  afin  de  ne  pas  mettre  en  danger  votre  santé  et  votre  vie,  ni  celles  d'autrui,  ni  d'endommager  
l'amplificateur  et  les  équipements  qui  lui  sont  connectés,  sans  que  cela  soit  couvert  par  la  garantie.  Le  fabricant  
décline  toute  responsabilité  quant  aux  actions  d'autrui,  et  la  responsabilité  incombe  à  l'auteur  de  l'opération.

Coupez  immédiatement  l'alimentation  et  contactez  votre  revendeur  pour  obtenir  de  l'aide  (voir  la  section
N'utilisez  JAMAIS  l'équipement  si  vous  remarquez  une  odeur,  un  bruit  ou  une  fumée  anormale.

Pour  être  en  conformité  avec  les  exigences  d'exposition  RF,  veuillez  lire  la  section

1.9  Assistance  au  propriétaire).

8.3.c)  Informations  sur  l’exposition  aux  RF.

AVERTISSEMENT

AVERTISSEMENT

AVERTISSEMENT
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Le  poids  emballé  est  d'environ  20  kg  et  il  est  recommandé  de  le  manipuler  par  deux  personnes.

Figure  2­1  |  Carton  d'emballage  (vue  extérieure)

Conservez  tous  les  matériaux  d'emballage  pour  une  éventuelle  expédition  future  du  tuner  d'antenne  (voir  la  section  

8.4.4  Retour  au  fournisseur  de  services).

Figure  2­1  |  Carton  d'emballage  (vue  extérieure)

Avant  d’installer  votre  amplificateur,  lisez  attentivement  ce  manuel.

ACOM  expédie  les  amplificateurs  dans  des  conteneurs  hautement  protégés,  mais  ne  peut  garantir  qu'ils  ne  seront  

pas  maltraités  par  les  transporteurs.  En  cas  de  dommage  évident,  prévenez  immédiatement  votre  revendeur.  Tout  

retard  peut  annuler  la  garantie  du  transporteur.

Tout  d’abord,  inspectez  soigneusement  le  carton  et  son  contenu  pour  détecter  tout  dommage  physique.

2.1.  Déballage  et  inspection  initiale

•  Ouvrez  le  carton  (voir  Figure  2­1  |  Carton  d'emballage  (vue  extérieure)  et

Figure  2­2  |  ACOM  1200S  emballé  dans  une  boîte  en  carton,  Pos.  1) ;  •  

Retirer  les  éléments  de  sécurité  supérieurs  (voir  

Figure  2­2  |  ACOM  1200S  emballé  dans  une  boîte  en  carton,  Pos.  2) ;  •  Ouvrir  le  

carton  intérieur  (voir  Figure  2­2  |  ACOM  1200S  

emballé  dans  une  boîte  en  carton,  Pos.  3) ;

Déballez  l'amplificateur  comme  décrit  ci­dessous :

Machine Translated by Google



Figure  2­2  |  ACOM  1200S  emballé  dans  une  boîte  en  carton

Figure  2­2  |  ACOM  1200S  emballé  dans  une  boîte  en  carton

•  Retirez  l'amplificateur  (Pos.  8)  de  l'élément  de  sécurité  central  et  retirez  les  éléments  de  sécurité  plats  supérieur,  
inférieur  et  latéraux  (voir  Figure  

2­2  |  ACOM  1200S  emballé  dans  une  boîte  en  carton,  Pos.  5,  6  et  7) ;

•  Retirer  l'amplificateur  à  l'aide  des  poignées  de  l'élément  de  sécurité  central  (voir  Figure  
2­2  |  ACOM  1200S  emballé  dans  une  boîte  en  carton,  Pos.  4) ;

Il  n'est  pas  nécessaire  de  retirer  les  éléments  de  sécurité  inférieurs.  (voir  
Figure  2­2  |  ACOM  1200S  emballé  dans  une  boîte  en  carton,  Pos.  9)
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•  L’amplificateur  est  maintenant  prêt  à  être  installé.
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L'ACOM  1200S  est  refroidi  par  air  pulsé.  Maintenez  une  distance  minimale  de  10  cm  (4  pouces)  avec  tout  autre  appareil  

ou  objet.

Figure  2­3  |  Panneau  avant  ­  Position  ergonomique  avec  barre  de  pied  inclinable

L'air  évacué  peut  atteindre  65  oC  (150  o  F)  et  si  les  appareils  environnants  sont  sensibles  au  chauffage  extérieur  ou  utilisent  eux­mêmes  un  

refroidissement  par  air  pulsé,  augmentez  les  distances  en  conséquence.

Figure  2­3  |  Panneau  avant  ­  Position  ergonomique  avec  barre  de  pied  inclinable

Placez  l'amplificateur  à  proximité  de  l'endroit  où  il  sera  utilisé.  L'accès  à  la  commande  sera  facile.

boutons  sur  le  panneau  avant,  ainsi  que  sur  le  câblage  du  panneau  arrière.

Le  poids  de  l'appareil  est  d'environ  16  kg,  il  est  donc  préférable  qu'il  soit  manipulé  par  deux  personnes.

2.2.  Sélection  de  l'emplacement  de  l'amplificateur

Ne  laissez  pas  de  papier,  de  tissu  ou  d'autres  objets  légers  autour  et  sous  l'amplificateur.  Ils  pourraient  être  aspirés  par  le  

flux  d'air  de  refroidissement  et  obstruer  les  orifices  de  ventilation.  Cela  entraînerait  une  surchauffe  et  un  vieillissement  

accéléré  du  matériau,  non  couverts  par  la  garantie.
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Grâce  au  SMPS  intégré,  l'ACOM  1200S  n'a  pas  de  sélecteur  de  tension  secteur  à  gérer !

Consultez  la  section  7.3  Remplacement  du  fusible  pour  connaître  la  valeur  nominale  correcte  du  fusible.

Veuillez  consulter  la  figure  2­4  |  Panneau  arrière  ­  Connexions.

La  connexion  à  votre  station  doit  être  effectuée  dans  l'ordre  décrit  ci­dessous,  avant  d'appliquer  la  tension  secteur  à  l'amplificateur.

L'amplificateur  ACOM  1200S  est  fourni  avec  une  alimentation  à  découpage  (SMPS)  intégrée.

2.4.  Connexions

L'amplificateur  fonctionne  sur  une  plage  de  tension  secteur  étendue  de  100  à  240  VCA,  sans  commutation  interne.  Le  courant  consommé  est  

purement  sinusoïdal,  corrigé  du  facteur  de  puissance  (PFC)  et  limité  en  courant  d'appel.  Cela  facilite  le  fonctionnement  sur  des  réseaux  et  des  

générateurs  instables.

2.3.  Sélection  de  la  tension  de  ligne

Figure  2­4  |  Panneau  arrière  ­  Connexions

Figure  2­4  |  Panneau  arrière  ­  Connexions

Les  normes  et  réglementations  locales  applicables  prévalent  en  cas  de  différence  dans  les  exigences  et  si  elles  contiennent  

des  exigences  plus  nombreuses  ou  plus  strictes  que  le  minimum  d'installation  indiqué  dans  notre  documentation.

L'installation  de  l'équipement  doit  être  conforme  aux  codes  électriques  locaux  et  nationaux.
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N'utilisez  pas  les  canalisations  des  réseaux  de  chauffage  à  vapeur  ou  d'eau  pour  la  mise  à  la  terre !  Vous  risquez  d'exposer  

vous­même,  mais  aussi  les  autres  personnes  utilisant  la  même  installation,  à  une  tension  dangereuse.

a)  Goujon  GND  pour  la  mise  à  la  terre

Portez  une  attention  particulière  aux  sections  2  à  3  Installation  de  l’unité  à  distance  dans  le  manuel  téléchargé ;

Avant  de  connecter  l'amplificateur  à  la  terre  externe,  vous  devez  consulter  un

Cet  amplificateur  doit  être  mis  à  la  terre.

électricien  agréé  et  confirmer  que  ce  type  de  connexion  est  autorisé  par  votre  pays

Lors  de  l'installation  ou  du  remplacement  de  l'appareil,  la  connexion  à  la  terre  doit  toujours  être  effectuée  en  premier  et  
déconnectée  en  dernier.

Portez  une  attention  particulière  à  l’annexe  1  –  Protection  contre  la  foudre  dans  le  manuel  téléchargé.

normes  et  réglementations  en  matière  de  sécurité  électrique,  de  sécurité  incendie  et  de  protection  contre  la  foudre.

Notez  que  le  système  de  mise  à  la  terre  peut  devoir  supporter  des  courants  supérieurs  à  15  A  avec  une  chute  de  tension  

négligeable.  Il  peut  donc  être  nécessaire  de  l'améliorer  considérablement,  c'est­à­dire  de  le  rendre  moins  résistif,  avec  des  

fils  plus  épais  et  un  chemin  de  terre  moins  résistif.

La  connexion  simultanée  à  la  terre  et  à  la  terre  de  protection  peut  être  inadmissible  ou  faire  l'objet  d'exigences  particulières  

dans  certains  pays !

Utilisez  un  fil  de  terre  vert  et  jaune  pour  connecter  le  goujon  de  mise  à  la  terre  de  l'écrou  à  oreilles  de  l'amplificateur  (sur  le  

panneau  arrière,  marqué  GND)  au  système  de  mise  à  la  terre  de  la  station.

(Voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (a))

N'utilisez  jamais  les  conduites  d'une  installation  de  gaz  pour  la  mise  à  la  terre.  Cela  pourrait  provoquer  une  EXPLOSION !

Les  fils  de  mise  à  la  terre  doivent  mesurer  au  moins  4  mm²  (AWG  11  ou  SWG  13).

Si  aucune  autre  donnée  n'est  disponible,  afin  d'éviter  la  conduction  d'un  coup  de  foudre  avec  toutes  les  conséquences  qui  en  

découlent  ­  décès,  blessures,  incendie,  dommages  matériels,  destruction,  etc.,  veuillez  lire  et  comprendre  clairement :

•  Manuel  d'utilisation  de  l'ACOM  04AT

•  Manuel  d'utilisation  de  l'ACOM  03AT
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Votre  amplificateur  NE  FONCTIONNERA  PAS  si  l'entrée  KEY  IN  n'est  pas  correctement  connectée.

(voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (c))  de  l'amplificateur.

Pour  plus  de  détails  et  de  recommandations  sur  le  système  de  mise  à  la  terre  et  de  contrepoids  RF  concernant  la  compatibilité  électromagnétique,  voir  

également  la  section  3.6.f)  Élimination  des  problèmes  de  compatibilité  électromagnétique  (CEM).

Les  fabricants  d'émetteurs­récepteurs  donnent  différents  noms  à  cette  sortie,  par  exemple  TX­GND,  SEND,  T/R­LINE,  PTT,  

etc.  Certains  émetteurs­récepteurs  exigent  que  la  « masse  à  l'émission »  soit

b)  Connecteur  KEY  IN

Mise  en  œuvre  via  une  commande  logicielle  ou  en  modifiant  le  réglage  d'un  commutateur  situé  sur  le  panneau  arrière  ou  à  

l'intérieur  de  l'émetteur­récepteur.  Consultez  le  manuel  de  votre  émetteur­récepteur.

Il  s'agit  de  l'entrée  de  l'amplificateur  pour  le  contrôle  de  réception/transmission  depuis  l'émetteur­récepteur.

c)  Connecteur  KEY  OUT

L'émetteur­récepteur  commute  l'amplificateur  du  mode  réception  au  mode  transmission  (RX/TX)  en  mettant  à  la  terre  l'  entrée  KEY  IN .

Il  s'agit  de  la  sortie  de  contrôle  permettant  la  transmission  de  l'amplificateur  vers  l'émetteur­récepteur.

Faites  passer  un  câble  blindé  du  connecteur  ou  de  la  borne  « terre  à  l'émission »  de  votre  émetteur­récepteur  jusqu'au

Le  connecteur  KEY  OUT  fournit  un  signal  de  commande  supplémentaire  de  l'amplificateur  à  l'émetteur­récepteur.  Il  permet  d'améliorer  la  sécurité  de  la  

commutation  réception/émission  (RX/TX).

Connecteur  KEY  IN  du  panneau  arrière  de  l'amplificateur  (voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (b)).  Le  connecteur  KEY  IN

utilise  une  prise  phono  RCA  standard.

KEY  OUT  est  une  sortie  à  drain  ouvert  de  faible  puissance,  assurez­vous  que  la  tension  du  signal  provenant  de  la  connexion  

de  l'émetteur­récepteur  respectif  ne  dépasse  pas  50  VDC  (circuit  ouvert)  et  que  le  courant  en  circuit  fermé  est  inférieur  à  20  
mA.

La  tension  de  commutation  entre  le  connecteur  KEY  IN  de  l'amplificateur  et  la  sortie  « masse  en  émission »  de  l'émetteur­

récepteur  ne  dépasse  pas  12 V  (positif  à  la  masse).  Le  courant  en  circuit  fermé  est  inférieur  à  6 mA  (voir  section 8.1.j)  

Contrôle  de  réception/émission.

Si  votre  émetteur­récepteur  dispose  d'une  entrée  appropriée  qui  désactive  la  transmission  à  moins  d'être  mise  à  la  terre  en  externe,  nous  vous  

recommandons  de  le  connecter  avec  un  câble  blindé  terminé  par  un  connecteur  Phono  (RCA)  au  connecteur  KEY  OUT
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Si  vous  utilisez  un  amplificateur  de  puissance  pour  la  première  fois  dans  votre  station,  vérifiez  le  type  de  câble  

coaxial  reliant  la  sortie  de  l'amplificateur  à  l'antenne.  Il  doit  supporter  la  puissance  accrue  en  toute  sécurité,  

notamment  sur  les  bandes  de  10  et  6  mètres.  Nous  recommandons  un  câble  RG213  ou  supérieur.  Vérifiez  également  
le  commutateur  et  le  tuner  d'antenne,  ainsi  que  l'ensemble  du  système  d'antenne  (en  particulier  les  antennes  pièges  

multibandes).

L'ACOM  1200S  fonctionnera  normalement  avec  KEY  OUT  non  connecté  si  votre  émetteur­récepteur  ne  dispose  pas  

d'une  telle  entrée.

Les  fabricants  d'émetteurs­récepteurs  donnent  des  noms  différents  à  cette  entrée,  par  exemple  TX­INHIBIT,  MUTE,  

LINEAR,  etc.  Consultez  le  manuel  de  votre  émetteur­récepteur.

Connectez  un  câble  coaxial  approprié  avec  une  fiche  PL­259  à  partir  de  la  SORTIE  RF  (voir  Figure  2­4  |  Panneau  arrière  ­

d)  Connecteur  d'ENTRÉE  RF

Connexions,  Pos.  (e))  au  commutateur  d'antenne  ou  au  tuner,  ou  à  l'antenne  pour  la  bande  de  fréquence  respective.

Connectez  un  câble  coaxial  approprié  de  la  sortie  de  l'émetteur­récepteur  au  connecteur  RF  INPUT  SO­239  de  l'amplificateur

Les  tuners  d'antenne  automatiques  ACOM  04AT  et  06AT  avec  commutateurs  d'antenne  à  quatre  voies  sont

(voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (d)),  en  utilisant  la  fiche  PL­259.

conçu  pour  fonctionner  avec  notre  série  d'amplificateurs  à  transistors  (à  semi­conducteurs),  y  compris  l'ACOM  

1200S  (voir  la  section  4.3  Fonctionnement  avec  un  tuner  d'antenne  externe).

L'utilisation  de  l'ACOM  06AT  ou  04AT  avec  un  amplificateur  ACOM  1200S  est  fortement  recommandée.

Afin  d'éviter  tout  dommage  (non  couvert  par  la  garantie),  désactivez  le  tuner  d'antenne  interne  de  votre  émetteur­
récepteur.

Nous  recommandons  de  coordonner,  avec  ACOM,  l'utilisation  de  tuners  d'antenne  non  ACOM  pour  la  connexion  à  
la  SORTIE  RF.

e)  Connecteur  de  SORTIE  RF

ACOM,  en  tant  que  fabricant  d'équipement  d'origine,  se  réserve  le  droit  de  refuser  les  demandes  de  garantie  si  un  

équipement  non  adapté  est  utilisé.
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Veuillez  consulter  la  figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (g).

En  raison  des  différentes  normes  en  vigueur  dans  les  différents  pays,  la  fiche  secteur  du  câble  d'alimentation  de  l'amplificateur  est

Fourni  et  monté  par  le  revendeur.  Il  branche  l'appareil  sur  une  prise  secteur  standard  conforme  à  la  norme  de  sécurité  de  classe  I  de  votre  pays.

Le  fil  de  terre  du  cordon  d'alimentation  de  l'amplificateur  est  jaune  avec  deux  bandes  vertes,  et  les  fils  bleu  et  marron  sont  actifs.  Si  l'amplificateur  est  

utilisé  avec  un  seul  fusible  secteur,  il  est  connecté  en  série  avec  le  fil  marron,  qui  doit  être  actif.

Veuillez  consulter  la  figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (f).

g)  L'entrée  d'alimentation  IEC  320­C14  (IEC  60320­C14)

Vérifiez  que  les  fusibles  principaux  de  votre  amplificateur  correspondent  à  la  tension  nominale  de  votre  réseau  électrique  local.  

Si  nécessaire,  remplacez­les  comme  décrit  à  la  section  7.3  « Remplacement  des  fusibles » !

f)  Fusibles  principaux

Le  câble  d'alimentation  (une  partie  de  la  livraison)  est  assemblé  en  usine  avec  une  fiche  d'alimentation  IEC  60320­C13  et  avec  une  extrémité  de  câble  

libre  de  l'autre  côté  (3х1,0  mm²,  longueur  1,80  m  (les  câbles  appropriés  sont  AWG  16  ou  SWG  18)).

Tableau  2­1  |  Connexions  du  cordon  d'alimentation

Si  vous  avez  des  doutes  sur  la  manière  correcte  de  connecter  les  fils,  consultez  votre  revendeur.

Tableau  2­1  |  Connexions  du  cordon  d'alimentation

NeutreN
ACOM

L

Description

Bleu

CouleursNom  du  fil

Terre  (conducteur  de  mise  à  la  terre  de  protection)

amplificateur Ligne,  actif,  en  direct Brun

Jaune  ­  VertG  ou  PE  ou  E
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Vérifiez  que  le  fusible  du  panneau  a  une  capacité  suffisante  pour  la  charge  supplémentaire  de  l'amplificateur,  comme  indiqué  dans  la  section  

Spécifications  8.1.h)  Consommation  secteur  à  pleine  puissance.  Si  vous  branchez  l'amplificateur  sur  une  autre  prise  secteur,  vérifiez­la  également.

2.5.  Connexion  à  des  périphériques  externes  (émetteur­récepteur,  ordinateur,  etc.)  et  paramètres  utilisateur

a)  Connecteur  d'interface  CAT/AUX

Veuillez  consulter  la  figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (1).

(jusqu'à  10  A  sur  secteur  200/240  VCA).  Assurez­vous  que  le  câble  de  terre  est  correctement  connecté  et  que  sa  

section  est  au  moins  égale  à  celle  du  conducteur  de  phase  de  la  prise  murale  de  l'amplificateur.

Il  est  préférable  d'utiliser  la  prise  murale  la  plus  proche  de  la  source.  Les  câbles  d'installation  doivent  avoir  une  section  minimale  de  1,5  mm²  

(AWG  15  ou  SWG  17)  pour  une  tension  de  fonctionnement  de  200­240  VCA  (valeurs  recommandées  en  l'absence  d'exigences  plus  strictes  

selon  la  norme  locale).

Avant  de  connecter  l'amplificateur  à  votre  alimentation  secteur  en  faisant  appel  à  un  électricien  agréé,  vérifiez  que  

l'alimentation  est  correctement  câblée  et  qu'elle  est  adaptée  au  courant  consommé  par  l'amplificateur.

h)  Préparation  de  la  prise  murale

L'interface  CAT/AUX  est  utilisée  pour  connecter  et  utiliser  différents  modèles  d'émetteurs­récepteurs  (voir  le  Tableau  2­2  |  Signaux  et  brochage  

du  connecteur  CAT/AUX  ci­dessous  et  le  menu  correspondant  dans  la  Section  5.3  Menu  PARAMÈTRES  CAT/AUX  (Sélection  de  l'interface  CAT/

AUX),  Tableau  5­1  |  Type  d'interface  d'émetteur­récepteur  et  sélection  du  jeu  de  commandes,  et

Le  câble  peut  être  commandé  séparément  auprès  d'un  fournisseur  tiers  ou  fabriqué  maison  conformément  au  tableau  2­2  |  Signaux  et  brochage  

du  connecteur  CAT/AUX  et  au  manuel  de  l'émetteur­récepteur.

La  connexion  CAT  nécessite  un  câble  spécialement  conçu  pour  l'ACOM  1200S  et  votre  émetteur­récepteur.  L'utilisation  

d'un  câble  inapproprié  peut  endommager  gravement  l'amplificateur  et  votre  émetteur­récepteur !

La  plupart  des  émetteurs­récepteurs  modernes  peuvent  être  connectés  par  câble  CAT  à  l'ACOM  1200S.  Cela  permet  à  l'amplificateur  de  suivre  

la  fréquence  de  l'émetteur­récepteur  sans  aucune  transmission  et  de  changer  automatiquement  de  bande  en  mode  OPERATE.

Figure  5­4  |  Menu  PARAMÈTRES  CAT/AUX).
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Veuillez  noter  que  certaines  connexions  (sorties  de  données  de  bande  BCD  et  de  tension  de  bande)  de  l'émetteur­

récepteur  ne  fournissent  pas  de  données  de  fréquence  exactes,  mais  uniquement  des  données  de  bande.  Ces  

connexions  ne  peuvent  pas  être  utilisées  lorsque  l'ACOM  1200S  fonctionne  avec  l'ACOM  04AT  ou  06AT,  car  le  tuner  

doit  connaître  la  fréquence  exacte,  et  pas  seulement  la  bande.

Tableau  2­2  |  Signaux  et  brochage  du  connecteur  CAT/AUX

Outre  l'interface  série  compatible  RS­232  et  TTL,  le  connecteur  CAT  transporte  également  les  lignes  KEY  IN  et  KEY  

OUT,  qui  peuvent  être  utilisées  au  lieu  d'utiliser  des  câbles  séparés  pour  ces  fonctions  de  l'émetteur­récepteur  aux  
prises  du  même  nom.

Si  vous  avez  besoin  de  schémas  de  câblage,  veuillez  consulter  notre  document

Tableau  2­2  |  Signaux  et  brochage  du  connecteur  CAT/AUX
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Interface  
CAT/AUX

9

Bit  3

connecteur,

15  broches,

•  Informations  techniques  sur  les  câbles  ACOM  CAT.

5  GND

Entrée  TTL

Transmettre  des  données

RxD

11  SUR  RMT

7

Entrée  analogique

Moins  de  +12  V /  6  mA

3

14

0  à  +8  V

(Vue  du  panneau  

arrière)

Numéro  de  broche

Données  de  bande  2

Mise  sous  tension  à  distance3  rangs,  
femelle

6

Transmettre  des  données

+4,5  à  +15  V /  3  mA  max

sortie  RS­232

SORTIE  DE  CLÉ

Données  de  bande  0 Bit  0

Sortie  OC,  jusqu'à  +50  V /  20  mA

TxD

Entrée  TTL

15  GND

4

Recevoir  des  données

Entrée  TTL

Prêt  pour  le  Tx

Sol

Nom  de  la  broche

10

Entrée  TTL

Mode  débogage

Sol

Tension  de  bande

2

12

Sortie  TTL

Entrée  d'alimentation  du  processeur  uniquement

Description

Bit  1Données  de  bande  1D­sub

TxD

Recevoir  des  données

Entrée  TTL

0  Volt

1

Données  de  bande  3

entrée  RS­232

SAISIE

+8  à  +15  V /  0,4  A

RxD

13

0  Volt

Demande  de  transaction

Spécification

8

Bit  2
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Veuillez  consulter  la  figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (2).

L'interface  RS­232  est  utilisée  pour  les  mises  à  jour  du  micrologiciel  (voir  Section  7.5  Micrologiciel)  et  pour  le  contrôle  à  distance  (voir  Section  6  

TÉLÉCOMMANDE).

b)  Connecteur  d'interface  RS­232

Tableau  2­3  |  Signaux  et  brochage  du  connecteur  RS­232

Tableau  2­3  |  Signaux  et  brochage  du  connecteur  RS­232
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connecteur,

­

DSR

Sortie  de  niveau  RS­232

(Vue  du  panneau  

arrière)

Spécification

Non  connecté

­

Transmettre  des  données

Numéro  de  broche

8

Non  connecté­

2

Nom  de  la  broche

0  Volt

Mise  sous  tension  à  distance

4

­

Entrée  de  niveau  RS­232

D­sub

­
Mise  sous  tension  à  distance

6

RxD

Description

9  
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(marqué  O/I  ou  OFF/ON)  est  allumé  (voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (3)).  Branchez  ensuite  la  fiche  secteur  de  

l'amplificateur  dans  la  prise  murale  prévue  à  cet  effet.  L'amplificateur  reste  éteint.

Figure  3­1  |  Panneau  avant  ­  Commandes  et  affichages

Après  avoir  suivi  toutes  les  instructions  de  la  section  2  INSTALLATION,  vérifiez  si  l'interrupteur  à  bascule  du  panneau  arrière

Une  condensation  est  probable  et  pourrait  endommager  les  circuits  haute  tension.  Dans  ce  cas,  attendez  au  moins  

4  heures.  Un  effet  similaire  peut  se  produire  après  un  réchauffement  rapide  de  la  salle  d'opération  (par  exemple,  

après  avoir  allumé  un  chauffage  puissant  dans  une  cabine  froide).

Le  branchement  à  chaud  est  techniquement  incorrect  et  constitue  une  mauvaise  pratique  pour  connecter  ou  

déconnecter  un  appareil  sous  tension.  Assurez­vous  que  l'appareil  est  éteint  avant  de  connecter  ou  de  déconnecter  

un  câble.

Pour  éviter  tout  dommage  (non  couvert  par  la  garantie),  ne  connectez  ou  ne  déconnectez  jamais  les  câbles  lorsque  

l'alimentation  est  appliquée  à  l'une  ou  l'autre  extrémité  du  câble.

Ne  mettez  pas  l'amplificateur  sous  tension  pendant  au  moins  deux  heures  après  l'avoir  déballé  dans  la  pièce  où  il  

sera  utilisé.  Soyez  particulièrement  vigilant  lorsque  vous  le  déplacez  d'un  endroit  très  froid  vers  un  endroit  chaud.

Figure  3­1  |  Panneau  avant  ­  Commandes  et  affichages
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Veuillez  consulter  la  Figure  3­1  |  Panneau  avant  ­  Commandes  et  affichages,  Pos.  (b).

3.3.  Mise  en  marche  initiale

3.1.  Mode  veille  basse  consommation  de  l'alimentation

Lorsque  le  voyant  est  allumé  en  rouge  et  que  l'écran  est  sombre,  l'amplificateur  est  en  mode  veille  basse  consommation  et  peut  être  allumé  en  

appuyant  sur  le  bouton  POWER .

Pour  démarrer  l'amplificateur,  maintenez  le  bouton  POWER  (alimentation)  du  panneau  avant  enfoncé  pendant  une  ou  deux  secondes.  Environ  dix  

secondes  plus  tard  (séquence  de  démarrage),  l'écran  clignote  et  affiche  l'écran  de  base  contenant  les  informations  de  l'amplificateur  (voir  Figure  3­2  

|  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  assigné).

Pour  couper  complètement  l'alimentation  secteur,  coupez  également  l'interrupteur  à  bascule  du  panneau  arrière  (voir  Figure  2­4  |  Panneau  arrière  ­  

Connexions,  Pos.  (3)).  Le  voyant  rouge  du  panneau  avant  doit  s'éteindre  et  le  bouton  d'alimentation  devient  inopérant.

Vous  pouvez  maintenant  activer  l'interrupteur  secteur  marqué  O/I  ou  OFF/ON  (voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (3)).  Cela  

activera  uniquement  le  mode  veille  basse  consommation  de  l'alimentation  de  l'amplificateur  et  la  LED  rouge  au­dessus  du  bouton  POWER  s'allumera  

(voir  Figure  3­1  |  Panneau  avant  ­  Commandes  et  affichages,  Pos.  (b)),  tandis  que  l'alimentation  principale  est  toujours  coupée  et  que  l'écran  est  

éteint.

L'amplificateur  peut  démarrer  en  mode  STANDBY  ou  OPERATE  en  fonction  des  paramètres  utilisateur  AUTO  OPERATE  (voir

3.2.  Panneau  avant

c)  Boutons  fonctionnels

Section  4.1.c)  Paramètres  utilisateur  AUTO  OPERATE).

a)  Bouton  POWER

Veuillez  consulter  la  Figure  3­1  |  Panneau  avant  ­  Commandes  et  affichages,  Pos.  (c).

Veuillez  consulter  la  Figure  3­1  |  Panneau  avant  ­  Commandes  et  affichages,  Pos.  (a).

Ces  six  boutons  fonctionnels  permettent  le  contrôle  manuel  (local)  de  l'amplificateur.  La  fonction  de  chaque  bouton  est  indiquée  sur  l'écran  situé  au­

dessus.  Selon  le  menu  affiché,  les  boutons  peuvent  avoir  des  fonctions  différentes.

Lorsque  l'interrupteur  à  bascule  du  panneau  arrière  est  activé,  appuyez  sur  le  bouton  POWER  et  maintenez­le  enfoncé  pendant  1  à  2  secondes  pour

(touche  programmable).

Démarrez  l'amplificateur.  Une  fois  l'amplificateur  allumé,  appuyez  sur  le  bouton  POWER  pour  l'éteindre  (retour  en  mode  veille  basse  consommation).

d)  Un  écran  couleur  haute  résolution  24  bits  affichant  les  informations  de  fonctionnement.

b)  Indicateur  LED  au­dessus  du  bouton  POWER

Veuillez  consulter  la  Figure  3­1  |  Panneau  avant  ­  Commandes  et  affichages,  Pos.  (d).
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Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (a).

Les  limites  de  la  bande  actuellement  sélectionnée  sont  affichées.  Si  l'amplificateur  ne  reçoit  aucune  donnée  de  fréquence  de  fonctionnement  

par  CAT  ou  via  RS­232,  il  basculera  sur  la  dernière  bande  utilisée.

Figure  3­2  |  Écran  de  base  sans  syntoniseur  d'antenne  ACOM  04AT  attribué

Deux  valeurs  de  fonctionnement  sélectionnées  dans  le  menu  AMP  MEASURE  seront  affichées  ici  (voir  Section  5.1  Menu  AMP  MEASURE  

(Mesures  de  l'amplificateur)).

a)  Zone  d'information  pour  la  bande  de  fréquence

Figure  3­2  |  Écran  de  base  sans  syntoniseur  d'antenne  ACOM  04AT  attribué

Les  zones  d’information  suivantes  doivent  être  distinguées  sur  l’écran  de  base :

3.4.  Écran  de  base

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (b).

Pour  des  informations  détaillées,  veuillez  vous  référer  à  4.1  Changement  des  modes  RX/TX  et  OPERATE/STANDBY ;  Réglage  utilisateur  

AUTO  OPERATE.

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (c).

b)  Valeurs  d'exploitation

c)  Indicateur  de  mode  de  fonctionnement  ­  OPR,  STB  ou  AUTO  OPER
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Il  est  interdit  d'entrer  dans  la  zone  rouge.  Affiche  la  puissance  réfléchie  par  l'antenne.

Le  clignotement  de  la  TÉLÉCOMMANDE  représente  le  flux  de  données  du  port  RS­232.

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (1).

d)  Indicateur  RX/TX

g)  Graphique  à  barres  et  affichage  de  la  température  du  transistor  PA

j)  Zone  des  messages  d'alarme

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (d).

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (g).

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (j).

L'indicateur  RX/TX  lit  la  demande  de  transmission  (entrée  KEY­IN).  L'indicateur  RX  est  vert  et  l'indicateur  TX  est  rouge.  L'indicateur  clignote  

fréquemment  si  la  demande  de  commutation  est  rejetée  par  le  contrôleur  d'amplificateur.

L'entrée  dans  la  zone  rouge  n'est  pas  autorisée.

Tous  les  messages  d'alarme  (AVERTISSEMENT  ou  DÉFAUT  LOGICIEL)  apparaissent  sur  fond  jaune  et  clignotent  fréquemment  afin  d'attirer  

l'attention  de  l'opérateur  (voir  Figure  4­4  |  Apparition  d'un  message  d'alarme).

e)  Graphique  à  barres  de  puissance  directe  et  affichage  numérique

h)  Informations  sur  l'interface  CAT

Les  messages  d'AVERTISSEMENT  n'apparaissent  que  temporairement  (pendant  environ  trois  secondes),  après  quoi  l'indication  est  rétablie  

automatiquement  (voir  Section  4.4.a)  Premier  niveau  de  protection  ­  AVERTISSEMENT).

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (e).

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (h).

Les  messages  SOFT  FAULT  apparaissent  dans  le  même  champ  mais  restent  à  l'écran  jusqu'à  ce  que  le  temps  AUTO  OPERATE  soit  écoulé  (voir  

Section  4.1.c)  Paramètres  utilisateur  AUTO  OPERATE)  ou  jusqu'à  ce  que  l'opérateur  appuie  sur  un  bouton.

Affiche  la  puissance  directe  injectée  dans  l'antenne.

Lorsque  CAT  est  désactivé,  ce  champ  est  ombré.

3.5.  Système  de  contrôle  ­  Boutons  et  menus

f)  Graphique  à  barres  et  affichage  de  la  puissance  réfléchie

i)  Champ  d'information  TÉLÉCOMMANDE

1)  Les  boutons  OPR/STB  et  BAND

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué  Pos.  (f).

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (i).

Les  boutons  OPR/STB  et  BAND  sont  utilisés  pour  le  contrôle  manuel  (local).
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Dans  chaque  menu,  le  bouton  le  plus  à  gauche  est  toujours  AIDE  et  celui  le  plus  à  droite  est  toujours  SORTIE ;

Pour  ce  test,  l'amplificateur  doit  être  entièrement  installé  et  connecté  conformément  à  la  section  2  « INSTALLATION »,  mais  hors  tension.  

L'interrupteur  d'alimentation  situé  sur  le  panneau  arrière  doit  être  éteint.  Dans  tous  les  cas,  la  LED  située  au­dessus  du  bouton  d'alimentation  sur  le  

panneau  avant  doit  être  éteinte.

•  Le  bouton  OPR/STB  le  plus  à  gauche  commute  l'amplificateur  entre  OPERATE  et

•  Le  bouton  AIDE  fournit  des  informations  sur  l’écran  actif.

Vérifiez  d'abord  si  la  réception  de  l'émetteur­récepteur  est  normale  dans  une  bande  qui  devrait  être  ouverte  au  moment  du  test.  Assurez­vous  de  

connecter  à  la  sortie  de  l'amplificateur  une  antenne  ayant  un  bon  TOS  dans  la  bande  testée.  Si  vous  constatez  une  dégradation  significative  de  la  

réception,  vérifiez  d'abord  s'il  y  a  un  problème  au  niveau  des  connexions  coaxiales  de  l'amplificateur  (voir  sections  2.4.d)  Connecteur  d'ENTRÉE  

RF  et  2.4.e)  Connecteur  de  SORTIE  RF).

Modes  VEILLE ;

Pour  plus  de  détails  sur  le  système  de  contrôle  et  l'utilisation  des  menus,  voir  la  Section  5  MENUS  ­  PARAMÈTRES  ET  OPTIONS.

Si  la  réception  est  normale,  préparez  l'émetteur­récepteur  comme  suit :

•  Les  deux  boutons  suivants  ­  flèches  haut  et  bas  BAND  ­  modifient  les  bandes  de  fréquences

Sélectionnez  un  mode  de  porteuse  continue  (CW,  RTTY,  FM) ;

ordre  croissant  ou  décroissant.

3.6.  Transmission  de  test

Lorsque  le  tuner  ACOM  04AT  ou  06AT  est  attribué,  les  boutons  BAND  sont  appelés  SEGMENT  et  modifient  les  segments  

de  fréquence  du  tuner  (voir  Section  4.3  Fonctionnement  avec  un  tuner  d'antenne  externe).

Pour  vous  assurer  que  vous  avez  correctement  installé  l'amplificateur,  effectuez  un  test  de  transmission  comme  décrit  ci­dessous.

2)  Bouton  MENU

Répétez  ces  tests  pour  chaque  nouvelle  bande  et  antenne,  ainsi  qu'après  l'installation  d'une  antenne  neuve  ou  réparée,  d'un  commutateur  

d'antenne,  d'un  tuner  et/ou  des  câbles  de  connexion.

Le  bouton  MENU  le  plus  à  droite  permet  d'accéder  aux  paramètres  et  aux  fonctions  de  service  de  l'amplificateur.

a)  Vérification  du  chemin  de  dérivation  RF  d'un  amplificateur  non  piloté

Veuillez  consulter  la  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (2).

Lorsque  l'ACOM  1200S  est  éteint,  il  y  a  une  dérivation  de  l'ENTRÉE  RF  vers  la  SORTIE  RF.

•  Éteignez  le  microphone  (diminuez  le  gain  du  micro),  désactivez  le  FSK ;

•  Réduire  la  puissance  de  sortie  au  minimum ;

•
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Si  le  ROS  reste  inférieur  à  2  (de  préférence  inférieur  à  1,5:1)  lors  du  dernier  test,  réduisez  à  nouveau  la  puissance  de  l'émetteur­récepteur  au  

minimum  et  continuez  avec  le  contrôle  suivant.

b)  Vérification  en  mode  STANDBY

Assurez­vous  que  l'amplificateur  est  en  mode  veille.  Appuyez  sur  le  bouton  OPR/STB  si  nécessaire  pour  passer  en  mode  STB.

La  précision  de  l'indication  de  puissance  est  optimisée  autour  du  niveau  de  1000  W  et  elle  n'est  généralement  pas  fiable  
en  dessous  de  50  W.

Si  l'émetteur­récepteur  dispose  d'un  tuner  d'antenne  intégré,  désactivez­le.

Si  la  puissance  et  le  ROS  sont  conformes  aux  attentes,  transmettez  à  nouveau  et  tout  en  surveillant  les  lectures  de  puissance  et  de  ROS,  

augmentez  progressivement  la  puissance  de  l'émetteur­récepteur  du  minimum  au  maximum  (mais  pas  plus  de  200  W,  afin  de  ne  pas  surcharger  

le  circuit  de  dérivation  RF  de  l'amplificateur).

En  mode  RÉCEPTION,  sélectionnez  une  fréquence  actuellement  libre  et  appuyez  brièvement  sur  la  touche  PTT  ou  TX  tout  en  observant  la  

puissance  de  sortie  et  le  TOS.  Si  la  puissance  ou  le  TOS  à  la  sortie  de  l'émetteur­récepteur  est  trop  élevé  (plus  de  5  W  ou  un  TOS  supérieur  à  

2:1),  relâchez  la  touche  et  recherchez  la  cause  comme  suit :

Sélectionnez  une  indication  appropriée  afin  de  pouvoir  surveiller  la  puissance  RF  et  le  ROS  à  la  sortie  de  l'émetteur­récepteur ;

Répétez  les  tests  de  réception  et  d'émission  comme  précédemment,  l'amplificateur  étant  éteint,  mais  en  mode  veille.  Pendant  ces  tests,  vérifiez  

également  si  le  graphique  à  barres  et  l'affichage  numérique  des  puissances  directe  et  réfléchie  (voir  sections  3.4.e)  et  3.4.f)  affichent  la  présence  

de  puissance  RF  correspondante.  Si  la  puissance  réfléchie  est  supérieure  à  la  puissance  directe,  vérifiez  que  les  câbles  coaxiaux  d'entrée  et  de  

sortie  de  l'amplificateur  ne  sont  pas  intervertis  (voir  sections  2.4.d)  ENTRÉE  RF

c)  Entrée  en  mode  OPERATE

En  mode  OPERATE,  la  réception  de  l'émetteur­récepteur  ne  devrait  pas  être  affectée.  Si  la  situation  empire  et  que,  malgré  le  changement  de  RX  

en  TX  (l'indicateur  est  allumé  alors  que  l'émetteur­récepteur  est  en  mode  réception),  vérifiez  le  câble  de  commande  connecté  à  la  touche  KEY  IN.

(voir  section  2.4.b)  connecteur  KEY  IN)  pour  détecter  un  court­circuit.  Une  mauvaise  connexion  à  l'émetteur­récepteur  pourrait  entraîner  le  même  

problème.

•  Vérifiez  si  la  fréquence  se  situe  dans  la  plage  de  fonctionnement  de  l’antenne  sélectionnée ;
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•  Vérifiez  le  bon  fonctionnement  des  câbles  coaxiaux,  des  connecteurs  et  des  lignes  d'alimentation  depuis  la  prise  
d'antenne  de  l'émetteur­récepteur  jusqu'à  l'amplificateur,  le  commutateur  d'antenne  ou  le  tuner  externe  (s'il  y  
en  a  un)  jusqu'au  transformateur  BALUN  et  l'antenne  elle­même  (voir  Section  2.4.e)  Connecteur  de  SORTIE  RF).
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•

•  Vérifiez  à  nouveau  si  le  contrôle  de  puissance  est  réglé  au  minimum ;

•
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connecteur  et  2.4.e)  connecteur  de  SORTIE  RF).

Allumez  l'amplificateur,  comme  décrit  dans  les  sections  3.1  Mode  veille  basse  consommation  de  l'alimentation,  3.2  Panneau  avant,  
3.3  Mise  sous  tension  initiale  et  3.4  Écran  de  base  (voir  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué).

Machine Translated by Google



Si  le  test  ci­dessus  se  déroule  normalement,  appuyez  à  nouveau  brièvement  sur  le  PTT,  cette  fois  en  surveillant  la  lecture  du  ROS  de  l'émetteur­

récepteur  (c'est­à­dire  le  ROS  d'entrée  de  l'amplificateur)  ­  celui­ci  doit  être  inférieur  à  1,2.

Si  le  ROS  de  l'émetteur­récepteur  est  supérieur  à  1,2,  vérifiez  le  câble  coaxial  entre  la  sortie  de  l'émetteur­récepteur  et  la  prise  d'entrée  de  

l'amplificateur  (voir  Section  2.4.d)  Connecteur  d'ENTRÉE  RF).

d)  Tester  la  transmission  avec  l'amplificateur

e)  Réglage  du  niveau  d'entraînement  et  fonctionnement  typique

Si  le  réglage  n'est  pas  facilement  effectué  par  CAT,  réglez  l'amplificateur  sur  la  même  bande  que  l'émetteur­récepteur  et  l'antenne  (voir  section  3.5.1)

Entrez  dans  le  menu  MESURE  (voir  Figure  5­2  |  Menu  AMP  MESURE)  et  vérifiez :

Après  avoir  réussi  les  tests  ci­dessus,  appuyez  sur  la  touche  PTT  ou  CW  pendant  quelques  secondes,  en  observant  la  puissance  directe  et  réfléchie.  

Augmentez  la  puissance  d'entraînement  jusqu'à  ce  que  le  graphique  de  puissance  directe  et  l'affichage  numérique  atteignent  1 000  W.

Réglez  l'émetteur­récepteur  en  mode  porteuse  continue  et  à  la  puissance  minimale.  En  mode  OPERATE,  choisissez  une  fréquence  libre  et  appuyez  

brièvement  sur  la  touche  PTT  ou  CW,  tout  en  observant  le  comportement  de  l'amplificateur :

Une  fois  la  puissance  directe  atteinte  à  1 000  W,  vérifiez  les  paramètres  suivants  (fonctionnement  en  porteuse  continue) :

•  TEMPÉRATURE  PA,  qui  doit  être  comprise  entre  la  température  ambiante  et  80  oC  (176  o  F),  en  fonction  du  niveau  de  puissance  et  

de  la  durée  de  transmission.

TOS  1,5);

f)  Élimination  des  problèmes  de  compatibilité  électromagnétique  (CEM)

Si  vous  utilisez  un  amplificateur  pour  la  première  fois  dans  votre  cabane,  vous  devrez  peut­être  améliorer  son  installation.  Vous  pourriez  ressentir  

des  picotements  provenant  d'objets  métalliques  en  raison  du  champ  RF  rayonné  plus  fort.

émetteur­récepteur  (entre  1  et  5  W) ;

limites  lors  du  changement  de  fréquence  de  fonctionnement  et  d'impédance  d'antenne ;

Cela  pourrait  affecter  le  fonctionnement  de  votre  station  ou  de  vos  systèmes  extérieurs  s'ils  sont  trop  sensibles  ­  des  exemples  typiques  sont  le  

microphone,  le  keyer  CW,  le  clavier  ou  la  souris  de  l'ordinateur,  ainsi  que  les  récepteurs  TV,  les  installations  Hi­Fi,  les  interphones  ou  les  téléphones  

et  autres.

•  La  puissance  réfléchie  ne  doit  pas  dépasser  ~110  W  (pour  un  ROS  2)  ou  mieux  encore  être  inférieure  à  40  W  (pour

•  Le  COURANT  DC  PA  doit  être  compris  entre  32  et  36  A.  Il  est  normal  que  le  courant  varie  dans  ces  limites

•  La  TENSION  CC  PA  doit  être  comprise  entre  48  et  52  V ;

•  La  lecture  du  ROS  de  l'émetteur­récepteur  doit  être  inférieure  à  1,2.

•  Le  mode  RX  doit  passer  à  TX ;

•  La  puissance  directe  doit  être  comprise  entre  20  et  150  W  avec  une  puissance  d'entraînement  minimale  du

•  La  puissance  réfléchie  doit  être  inférieure  à  20  W ;
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•  PA  BIAS,  doit  être  compris  entre  1,8  et  2,0  V  (typiquement  1,9  V) ;

•  La  puissance  d’entraînement  de  l’émetteur­récepteur  doit  être  comprise  entre  30  et  50  W ;

Les  boutons  OPR/STB  et  BAND).
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Les  résultats  des  appareils  sont  très  efficaces,  à  condition  qu'ils  soient  applicables  dans  la  pratique.

Enfin  et  surtout,  il  faut  garder  à  l’esprit  que  l’avantage  des  mesures  ci­dessus  est  double.

Si  l'utilisation  d'antennes  filaires  asymétriques  à  alimentation  directe  est  inévitable,  privilégiez  les  antennes  demi­onde  ou  demi­

onde  multiple :  elles  présentent  une  impédance  d'entrée  élevée  et  fonctionnent  avec  un  faible  courant  au  point  d'alimentation  

et  à  la  terre  de  la  cabane.  Ainsi,  vous  pouvez  réduire  l'intensité  des  champs  RF  perturbateurs  de  plus  de  dix  fois  (à  puissance  

rayonnée  égale)  par  rapport  aux  antennes  quart  d'onde  et  multiples  à  quart  d'onde  de  cette  classe.  Il  est  conseillé  de  les  éviter,  

car  elles  présentent  une  faible  impédance  d'entrée  et  fonctionnent  avec  un  courant  RF  important  au  niveau  de  la  terre  et  du  

réseau  d'alimentation,  créant  ainsi  des  perturbations  RF  plus  importantes.

Si  vous  utilisez  des  antennes  asymétriques  (GP  et  similaires),  installez  autant  de  radiaux  que  possible  (utilisez  un  système  de  

contrepoids  bien  développé) ;

Placez  les  éléments  rayonnants  des  antennes  le  plus  loin  possible  (y  compris  en  hauteur)  des  locaux  où  se  trouvent  les  

appareils  concernés.  De  ce  fait,  les  antennes  asymétriques  sans  alimentation  séparée  (Long  Wire,  Windom  et  similaires)  

peuvent  générer  davantage  d'interférences,  car  leur  élément  rayonnant  part  directement  de  la  cabane  (l'alimentation  elle­même  

en  fait  partie).

améliorer  l’équilibre  des  antennes  et  des  lignes  d’alimentation ;

Par  exemple,  l'induction  de  courants  RF  dans  le  microphone,  le  manipulateur  CW  ou  le  clavier  d'ordinateur  peut  entraîner  une  distorsion  des  pics  

ou  des  oscillations  de  relaxation  en  mode  SSB,  le  blocage  ou  la  rupture  des  points  ou  des  traits  d'un  manipulateur  Morse,  ou  encore  une  distorsion  

des  images  à  l'écran.  Pour  éliminer  ces  problèmes,  nous  vous  recommandons  de  prendre  les  mesures  générales  suivantes :

Premièrement,  ils  réduisent  les  interférences  de  vos  transmissions  avec  l'environnement  ambiant  et  deuxièmement,

ils  réduisent  le  bruit  de  fond  de  votre  réception.

•

•

Améliorer  le  système  de  mise  à  la  terre  RF :  utiliser  les  bandes  métalliques  les  plus  courtes  et  les  plus  larges  
possibles  pour  les  connexions  à  la  terre  et  entre  les  différents  équipements  de  la  cabane.  Connecter  un  ou  
plusieurs  contrepoids  (dimensionnés  pour  la  bande  problématique)  au  blindage  de  l'alimentation  à  son  point  
d'entrée  dans  le  bâtiment,  et  au  même  point,  avec  les  connexions  les  plus  courtes  et  les  plus  larges  possibles,  
au  système  de  mise  à  la  terre :  cette  mesure  est  très  efficace,  en  particulier  si  la  cabane  est  située  à  un  étage  
élevé.

•  Pour  réduire  l'impédance  RF  des  connexions  de  mise  à  la  terre,  il  est  préférable  d'utiliser  des  bandes  de  tôle  plutôt  
que  des  tresses  flexibles ;

•  Minimiser  le  rayonnement  des  lignes  d’alimentation  en  réduisant  les  courants  de  mode  commun  dans  celles­ci,

•

•  Ajouter  des  selfs  de  courant  sur  les  lignes  coaxiales ;
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Enfiler  des  perles  de  ferrite  ou  des  ferrites  à  encliqueter  de  perméabilité  moyenne  (800­4000)  sur  le  cordon  
d'alimentation,  le  câble  d'alimentation  et  les  câbles  de  signal  reliant  les  appareils  concernés  (téléviseur,  etc.) ;  
outre  la  taille,  tenir  compte  de  la  plage  de  fréquences  dans  laquelle  les  ferrites  proposées  sont  efficaces ;  
elles  sont  généralement  optimisées  pour  la  suppression  des  interférences  en  HF  (avec  une  perméabilité  plus  
élevée),  en  HF­VHF  (avec  une  perméabilité  moyenne)  ou  en  VHF  (avec  une  faible  perméabilité).  Ces  
dernières  sont  inefficaces  en  HF ;

•  Dans  la  mesure  du  possible,  utilisez  des  câbles  blindés  et  reliez  leurs  blindages  à  la  terre  aux  deux  extrémités ;

•  L'ajout  de  filtres  passe­bas  L/C  ou  R/C,  même  très  simples,  directement  aux  entrées  perturbées  ou
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En  pratique,  sans  grand  effort,  en  appliquant  les  mesures  ci­dessus,  vous  pouvez  réduire  le  bruit  de  fond  de  réception  
avec  une  ou  plusieurs  unités  S  sur  les  différentes  bandes.  Cela  vous  permettra  de  ne  pas  manquer  les  stations  plus  
faibles,  qui  vous  entendront  grâce  à  votre  puissance  d'émission  accrue.

Et  troisièmement,  mais  très  important :  l’environnement  EMI  de  votre  station  deviendra  plus  sûr  pour  vous  et  vos  proches.

Août  2024
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4.  FONCTIONNEMENT

•  Par  une  commande  à  distance.

Août  2024

•  Automatiquement  en  cas  de  déclenchement  de  la  protection  SOFT  FAULT  ­  lorsque  le  réglage  utilisateur  AUTO  OPERATE  est
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En  mode  OPERATE,  la  direction  de  réception­émission  (RX/TX)  est  contrôlée  par  l'  entrée  KEY  IN :

•  Manuellement  (localement)  ­  en  appuyant  alternativement  sur  le  bouton  OPR/STB  (voir  Figure  3­2  |  Écran  de  base

•  Lorsque  la  touche  KEY  IN  est  ouverte  (mode  OPERATE/RX),  l'émetteur­récepteur  reçoit  les  signaux  de  l'antenne  via  le  même  chemin  de  

dérivation  RF  entre  l'ENTRÉE  RF  et  la  SORTIE  RF  qu'avec  l'amplificateur  éteint  ou  en  mode  VEILLE ;

4.1.  Changement  des  modes  RX/TX  et  FONCTIONNEMENT/VEILLE ;  Réglage  utilisateur  du  fonctionnement  automatique

•  Lorsque  la  touche  est  mise  à  la  terre  (mode  OPERATE/TX),  le  signal  RF  est  amplifié  et  transmis  à  l'antenne

activé  (voir  Section  4.1.c)  AUTO  OPERATE  paramètres  utilisateur) ;

a)  Mode  VEILLE

via  le  connecteur  RF  OUTPUT .

En  mode  STANDBY,  ainsi  que  lorsque  l'amplificateur  est  éteint,  la  réception  et  la  transmission  (pas  plus  de  200  W)  avec  

l'émetteur­récepteur  se  font  via  un  chemin  de  dérivation  RF

L'émetteur­récepteur  doit  envoyer  un  signal  de  masse  à  l'  entrée  KEY  IN  de  l'amplificateur  au  moins  25  ms  avant  d'envoyer  le  

signal  de  commande  RF  à  l'  entrée  RF  de  l'amplificateur.  Ce  délai  (25  ms  ou  plus)  est  nécessaire  pour  que  les  relais  de  

l'amplificateur  passent  en  toute  sécurité  de  l'état  de  réception  à  l'état  d'émission.

sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (1));

via  l'ENTRÉE  RF  vers  la  SORTIE  RF  de  l'amplificateur.

Lisez  le  manuel  de  votre  émetteur­récepteur  pour  obtenir  des  instructions.

En  mode  STANDBY,  ainsi  que  lorsque  l'amplificateur  est  éteint,  la  puissance  RF  de  l'émetteur­récepteur  n'est  pas  amplifiée,  l'entrée  de  commande  KEY  

IN  n'affecte  pas  le  fonctionnement,  et  la  sortie  KEY  OUT  (voir  Section  2.4.c)  KEY  OUT

Dans  le  cas  contraire,  le  système  de  protection  indiquera  « TENTATIVE  DE  COMMUTATION  À  CHAUD »  et  se  déclenchera.

Le  connecteur  (connecteur  KEY  IN)  suit  inconditionnellement  l'  entrée  KEY  IN .  Les  bandes  ne  peuvent  être  modifiées  ni  manuellement,  ni  par  CAT,  ni  à  

distance.

En  mode  OPERATE,  la  sortie  KEY  OUT  (voir  section  2.4.c)  (connecteur  KEY  OUT)  suit  l'  entrée  KEY  IN  uniquement  lorsque  toutes  les  conditions  de  

transmission  sûre  ont  été  vérifiées  par  l'unité  de  commande  de  l'amplificateur.  Lorsqu'elle  est  utilisée,  la  sortie  KEY  OUT  désactive  la  transmission  tant  

que  l'amplificateur  n'est  pas  prêt.

b)  Mode  FONCTIONNEMENT

Les  deux  modes  OPERATE  et  STANDBY  peuvent  être  modifiés  de  trois  manières :
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4.2.  Changement  de  bande,  couverture  de  fréquences  standard  et  étendue

L'accès  au  mode  OPERATE  peut  être  verrouillé  dans  le  menu  AMP  SERVICE,  le  paramètre  utilisateur  OPERATE  ACCESS  

(voir  Section  5.4  Menu  PREFERENCES  UTILISATEUR  et  5.4.e)  OPERATE  ACCESS).

Lorsqu'il  est  connecté  à  un  émetteur­récepteur  avec  CAT,  l'amplificateur  changera  automatiquement  de  bande  de  fréquence,  en  suivant  les  

changements  de  fréquence  de  fonctionnement  de  l'émetteur­récepteur.

c)  Paramètres  utilisateur  AUTO  OPERATE

Sans  connexion  CAT,  les  bandes  peuvent  être  modifiées  manuellement  ou  automatiquement  (par  le  compteur  de  fréquence  intégré).

Le  paramètre  utilisateur  AUTO  OPERATE  peut  être  activé/désactivé  par  l'opérateur  dans  le  menu  PRÉFÉRENCES  UTILISATEUR  (voir  Section  5.4  Menu  

PRÉFÉRENCES  UTILISATEUR  et  Figure  5­5  |  Menu  PRÉFÉRENCES  UTILISATEUR)  ou  par  une  commande  à  distance.

Les  bandes  sont  modifiées  manuellement  à  l'aide  des  boutons  BAND  haut  et  bas .

Lorsque  le  mode  AUTO  est  désactivé,  les  deux  modes  (FONCTIONNEMENT  et  VEILLE)  peuvent  être  commutés  alternativement  via  le  bouton  OPR/

STB  ou  une  télécommande.  En  cas  de  déclenchement  de  la  protection  SOFT  FAULT,  l'amplificateur  repasse  en  mode  VEILLE  et  attend  que  

l'opérateur  le  remette  en  marche  en  appuyant  sur  le  bouton  OPR/STB.

Pour  un  changement  de  bande  automatique  via  le  compteur  de  fréquence  intégré,  faites  une  pré­transmission  assez  courte  (100  ms  suffisent  ­  un  dit  

CW,  ou  un  son  sur  SSB)  et  relâchez  le  PTT  un  instant  avant  le  principal

bouton.

transmission.

Lorsque  le  mode  AUTO  OPERATE  est  activé  (voir  la  section  5.4  Menu  PRÉFÉRENCES  UTILISATEUR),  l'amplificateur  démarre  en  mode  OPERATE

Si  la  nouvelle  fréquence  est  hors  de  la  plage  de  fréquences  de  l'amplificateur  (voir  Section  8.1.a)  Couverture  de  fréquence  standard),  la  demande  de  

transmission  sera  refusée  et  le  message  d'erreur  suivant  apparaîtra  à  l'écran :

dès  sa  mise  sous  tension.  En  cas  de  déclenchement  de  la  protection  SOFT  FAULT,  l'amplificateur  repasse  également  en  mode  STANDBY,  mais  

revient  automatiquement  en  mode  OPERATE  au  bout  de  4  secondes  environ.

« FRÉQUENCE  HORS  DE  PORTÉE »

Même  lorsque  le  mode  AUTO  est  activé,  l'opérateur  peut  revenir  en  mode  VEILLE  et  y  rester  manuellement  à  l'aide  du  bouton  OPR/STB  ou  d'une  

télécommande.  Un  nouvel  appui  sur  le  bouton  OPR/STB  ou  une  nouvelle  commande  à  distance  fera  passer  l'amplificateur  en  mode  

FONCTIONNEMENT  et  rétablira  le  fonctionnement  normal  défini  par  l'utilisateur.

Les  spécifications  de  l'amplificateur  sont  garanties  dans  les  bandes  répertoriées  dans  la  section
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Les  antennes  ACOM  04AT  et  06AT  s'accordent  automatiquement  avec  des  TOS  jusqu'à  3:1,  fournissant  ainsi  une  charge  optimale  à  

l'amplificateur  en  5  secondes,  avec  une  suppression  des  harmoniques  améliorée.  Le  commutateur  d'antenne  à  quatre  voies  est  commandé  

automatiquement  ou  depuis  le  panneau  avant  de  l'amplificateur.

L'ACOM  04AT  peut  être  installé  aussi  bien  en  cabane  qu'à  distance  (même  en  plein  air,  à  proximité  des  antennes).  Il  peut  être  éloigné  

jusqu'à  100  m  (330  pi)  de  l'amplificateur  grâce  à  un  simple  câble  coaxial.

Figure  4­1  |  Syntoniseur  et  commutateur  d'antenne  automatique  à  distance  ACOM  04AT

Pour  éviter  tout  dommage  (non  couvert  par  la  garantie),  ne  changez  pas  d'antenne  pendant  la  transmission.  

N'émettez  pas  sur  une  sortie  d'antenne  si  celle­ci  n'est  pas  connectée  à  une  antenne  ou  à  une  charge  fictive  via  un  

câble  coaxial  adapté  avec  une  prise  PL­259  (voir  section  2.4.e)  Connecteur  de  sortie  RF).

Le  syntoniseur  et  commutateur  d'antenne  automatique  à  distance  ACOM  04AT  (voir  Figure  4­1  |  Syntoniseur  et  commutateur  d'antenne  

automatique  à  distance  ACOM  04AT)  et  le  syntoniseur  et  commutateur  d'antenne  automatique  ACOM  06AT  (voir  Figure  4­2  |  Syntoniseur  et  

commutateur  d'antenne  automatique  ACOM  06AT)  sont  conçus  pour  fonctionner  avec  la  série  d'amplificateurs  à  transistors  (à  semi­

conducteurs)  ACOM,  y  compris  l'ACOM  1200S.

Avec  un  ROS  d'antenne  supérieur  à  1,5:1,  il  est  conseillé  d'utiliser  un  tuner  externe.

4.3.  Fonctionnement  avec  un  tuner  d'antenne  externe

La  connexion  du  tuner  ACOM  04AT  ou  06AT  rendra  accessibles  des  fonctionnalités  spécifiques  sur  l'écran  de  l'amplificateur  qui  assurent  un  

fonctionnement  transparent  en  suivant  les  changements  de  fréquence  et  de  sélection  d'antenne  en  moins  de  50  ms.

Le  tuner  ACOM  06AT  est  conçu  pour  une  utilisation  en  intérieur  uniquement !  Il  peut  être  placé  jusqu'à  100 m  (330 pi)  de  la  cabane,  à  l'aide  

d'un  simple  câble  coaxial.

Figure  4­1  |  Syntoniseur  et  commutateur  d'antenne  automatique  à  distance  ACOM  04AT
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Figure  4­3  |  Écran  de  l'amplificateur  avec  tuner  d'antenne  ACOM  04AT  ou  06AT  installé

•  Manuel  d'utilisation  ACOM  06AT.
•  Manuel  d'utilisation  de  l'ACOM  04AT ;

Figure  4­2  |  Tuner  et  commutateur  d'antenne  automatique  ACOM  06AT
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Figure  4­3  |  Écran  de  l'amplificateur  avec  tuner  d'antenne  ACOM  04AT  ou  06AT  installé

Portez  une  attention  particulière  aux  sections  3.2  Indications,  commandes  et  menus  et  4.2  Affectation  et  
désaffectation  du  tuner  dans  le  manuel  téléchargé  pour  plus  de  détails  sur  le  contrôle  ACOM  04AT  ou  06AT  
depuis  le  panneau  avant  de  l'amplificateur.

Le  fonctionnement  des  amplificateurs  ACOM  série  S  (dispositifs  à  semi­conducteurs)  avec  ACOM  04AT  et  
06AT  est  décrit  en  détail  dans  le  manuel  d'utilisation  respectif :

Figure  4­2  |  Tuner  et  commutateur  d'antenne  automatique  ACOM  06AT

L'utilisation  de  tuners  d'antenne  non  ACOM  n'est  pas  recommandée.

ACOM,  en  tant  que  fabricant  d'équipement  d'origine,  se  réserve  le  droit  de  refuser  les  demandes  de  garantie  si  
un  tuner  non  ACOM  est  utilisé.
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En  cas  de  dépassement  d'une  limite  de  paramètre,  l'amplificateur  évalue  le  risque  et  déclenche  l'un  des  trois  niveaux  de  protection  décrits  aux  points  (a)  

à  (c)  ci­dessous.  Chaque  événement  est  accompagné  d'un  message  d'avertissement  à  l'écran  (voir  Figure  4­4  |  Apparition  d'un  message  d'alarme).  Une  

alarme  sonore  est  également  émise  si  elle  est  activée  dans  les  PRÉFÉRENCES  UTILISATEUR  (voir  Figure  5­5  |  Menu  PRÉFÉRENCES  UTILISATEUR).

Figure  4­4  |  Apparence  d'un  message  d'alarme

a)  Premier  niveau  de  protection  ­  AVERTISSEMENT

ou  un  autre  (voir  Figure  4­4  |  Apparition  d'un  message  d'alarme).

L'unité  de  contrôle  ACOM  1200S  (voir  Section  7.4  Utilisation  des  codes  d'erreur  (signatures)  pour  les  diagnostics)  garde  une  trace  de  la  plupart  des  

signaux  analogiques  et  logiques  de  l'amplificateur  dans  tous  les  modes.

Figure  4­4  |  Apparence  d'un  message  d'alarme

Il  s'agit  du  signal  de  commande  de  réception/émission,  de  l'état  et  des  temps  de  commutation  des  contacts  du  relais  de  sortie,  de  la  fréquence  et  de  la  

puissance  de  commande  RF  (puissance  d'entrée),  du  courant  et  de  la  tension  continus  des  transistors  finaux  sur  les  drains,  ainsi  que  de  la  tension  de  

polarisation  des  grilles  et  de  la  température  du  dissipateur  thermique,  de  la  température  des  composants  de  l'alimentation  principale,  des  puissances  

directe  et  réfléchie  de  sortie  RF,  etc.  Certains  paramètres  dérivés,  tels  que  le  gain  de  puissance  et  le  ROS  de  l'antenne,  sont  également  surveillés.

4.4.  Système  de  protection  automatique

« PUISSANCE  D'ENTRAÎNEMENT  TROP  ÉLEVÉE »

Le  premier  niveau  de  protection  (le  plus  tolérant)  est  « AVERTISSEMENT ».  Lorsqu'une  valeur  surveillée  par  l'unité  de  contrôle  approche  du  seuil  de  

protection,  la  transmission  n'est  pas  interrompue,  mais  un  message  s'affiche,  par  exemple :

« COURANT  DE  DÉBIT  TROP  ÉLEVÉ »
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Un  DÉFAUT  SOFT  nécessite  des  actions  de  correction  rapides  et  simples  de  la  part  de  l'opérateur,  telles  que,  par  exemple,  la  réduction  de  la  puissance  

d'entraînement,  l'amélioration  du  ROS  de  charge  par  le  réaccord  du  tuner  d'antenne,  le  changement  d'antenne,  etc.

Vous  pouvez  continuer  à  émettre  dans  ces  conditions,  mais  vous  pouvez  prendre  certaines  mesures,  par  exemple  réduire  légèrement  la  puissance  de  l'émetteur­

récepteur.  Les  avertissements  restent  affichés  à  l'écran  pendant  au  moins  trois  secondes  pour  permettre  leur  lecture  et  disparaissent  une  fois  la  cause  résolue.

c)

b)  Deuxième  niveau  de  protection  ­  DÉFAUT  LOGICIEL

Troisième  niveau  de  protection  ­  DÉFAUT  GRAVE

Le  deuxième  niveau  de  protection  est  un  SOFT  FAULT  ­  lorsqu'une  valeur  dépasse  le  niveau  de  sécurité,  mais  ne  met  pas  l'amplificateur  en  danger  de  panne.

Le  troisième  niveau  de  protection,  le  plus  grave,  est  le  défaut  grave.  L'amplificateur  s'éteint  automatiquement  pour  éviter  d'éventuels  dommages  supplémentaires.

Au  deuxième  niveau  (PANNE  LOGICIELLE),  l'amplificateur  repasse  en  mode  VEILLE  pendant  quatre  secondes  ou  définitivement  si  le  réglage  utilisateur  AUTO  

OPERATE  a  été  activé  (voir  section  4.1.c)  Réglages  utilisateur  AUTO  OPERATE).  Un  message  correspondant  s'affiche  à  l'écran,  par  exemple :

Lorsqu'une  protection  contre  les  défauts  graves  se  déclenche,  les  données  relatives  au  défaut  sont  enregistrées  en  mémoire  et  l'écran  du  panneau  avant  s'éteint.  

Une  alarme  sonore  se  déclenche  également :  une  série  de  « F »  est  émise  en  continu.

« PUISSANCE  RÉFLÉCHIE  EXCESSIVE »

Si  la  cause  du  déclenchement  de  la  protection  n'est  pas  évidente,  vous  pouvez  essayer  de  remettre  l'amplificateur  sous  tension.  Si  l'amplificateur  le  permet  après  

le  défaut,  un  message  d'erreur  s'affichera  avec  des  informations  sur  la  raison  du  dernier  arrêt  automatique  (par  exemple,  surchauffe  du  bloc  d'alimentation  ou  de  

l'étage  de  sonorisation).

« COURANT  DE  DÉCHARGE  EXCESSIF »

Après  avoir  appuyé  sur  un  bouton,  le  message  d'erreur  disparaît  et,  en  l'absence  d'autres  problèmes  (par  exemple,  si  l'appareil  surchauffé  a  refroidi),  l'amplificateur  

est  rétabli.  Si  un  seuil  est  toujours  dépassé,  un  nouveau  message  s'affiche  à  l'écran  ou  la  protection  se  déclenche  à  nouveau  immédiatement  après  la  tentative  de  

rétablissement.

et  d'autres,  accompagnés  d'une  alarme  sonore  (à  moins  que  le  son  n'ait  pas  été  coupé  (voir  Section  5.4  Menu  PRÉFÉRENCES  UTILISATEUR).

Si  le  problème  persiste,  contactez  votre  concessionnaire  (voir  Section  1.9  Assistance  au  propriétaire).

Contrairement  à  ceux  d'un  AVERTISSEMENT,  les  messages  SOFT  FAULT  restent  à  l'écran  et  persistent  jusqu'à  ce  que  l'opérateur  appuie  sur  un  bouton  ­  afin  de  

confirmer  que  le  message  est  lu  ­  ou  jusqu'à  ce  que  le  mode  OPERATE  soit  repris  automatiquement  si  le  paramètre  utilisateur  AUTO  OPERATE  est  actif  (voir  

Section  5.4  Menu  PREFERENCES  UTILISATEUR).
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À  chaque  arrêt  dû  à  un  défaut  grave,  l'amplificateur  enregistre  les  données  de  diagnostic  concernant  les  commandes  et  les  valeurs,  le  temps  de  

déclenchement,  etc.  Votre  revendeur  ou  son  service  après­vente  peut  vous  demander  de  copier  ou  de  photographier  les  données  depuis  l'écran  

de  l'amplificateur,  ou  de  les  télécharger  via  l'interface  RS­232  et  de  les  enregistrer  dans  un  fichier  informatique  (voir  les  sections  5.5  Menu  

JOURNAL  DES  DÉFAUTS  et  7.5  Micrologiciel).
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Figure  5­1  |  SÉLECTION  DU  MENU

Les  éléments  de  chaque  menu  sont  sélectionnés  et  contrôlés  par  les  mêmes  six  boutons  que  dans  l'écran  de  base,  mais  ils  ont  
désormais  de  nouvelles  fonctions.

En  appuyant  sur  le  bouton  MENU  (le  plus  à  droite  sur  la  Figure  3­2  |  Écran  de  base  sans  syntoniseur  d'antenne  ACOM  04AT  assigné),  
l'utilisateur  accède  à  l'écran  de  SÉLECTION  DU  MENU  (voir  Figure  5­1  |  SÉLECTION  DU  MENU).  Chaque  menu  peut  être  sélectionné  
à  l'aide  des  boutons  ITEM  ou  ITEM  et  SELECT .  Ces  boutons  sont  décrits  ci­dessous.

Figure  5­1  |  SÉLECTION  DU  MENU
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Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué,  Pos.  (b))  ­  après  avoir  quitté  ce  menu  (EXIT

bouton).

Figure  5­2  |  Menu  MESURE  D'AMPLIFICATION

Figure  5­2  |  Menu  MESURE  D'AMPLIFICATION

Deux  listes  identiques  apparaissent  sur  les  moitiés  gauche  et  droite  de  l'écran,  chacune  contenant  les  mêmes  11  valeurs.

N'importe  quelle  valeur  peut  être  sélectionnée  dans  chaque  moitié  d'écran.  À  l'aide  des  boutons  ITEM  et  ITEM  (flèches  haut  et  bas),  sélectionnez  les  

valeurs  souhaitées.  Les  deux  valeurs  actuellement  sélectionnées  s'afficheront  également  en  continu  sur  l'écran  principal  (voir

Le  menu  MESURE  D'AMPLIFICATION  (voir  Figure  5­2  |  Menu  MESURE  D'AMPLIFICATION)  est  accessible  depuis  l'écran  SÉLECTION  DU  

MENU  (voir  Figure  5­1  |  SÉLECTION  DU  MENU)  dans  tous  les  modes.  Vous  pouvez  y  consulter  en  permanence  les  valeurs  de  onze  paramètres.

5.1.  Menu  AMP  MEASURE  (Mesures  d'amplificateur)

L'amplificateur  ACOM  n'est  pas  un  instrument  de  mesure  au  sens  d'un  instrument  étalonné  (de  laboratoire),  c'est­à­dire  que  les  

valeurs  mesurées  ne  peuvent  pas  être  utilisées  comme  référence  ou  comparées  à  d'autres  valeurs  mesurées  provenant  

d'instruments  étalonnés  (de  laboratoire).

Les  valeurs  mesurées  des  grandeurs  dans  le  menu  AMP  SERVICE  ne  sont  données  qu'à  titre  indicatif.

Machine Translated by Google



La  fonction  de  service  souhaitée  est  sélectionnée  à  l'aide  des  boutons  ITEM  et  ITEM  (flèches  haut  et  bas).  Les  boutons  SELECT  et  
SELECT  (flèches  gauche  et  droite)  permettent  d'activer  ou  de  désactiver  la  fonction  sélectionnée.

bouton,  l'écran  de  base  revient  (voir  Figure  3­2  |  Écran  de  base  sans  tuner  d'antenne  ACOM  04AT  attribué).

Figure  5­3  |  Menu  AMP  SERVICE

Figure  5­3  |  Menu  AMP  SERVICE

Le  menu  de  service  de  l'amplificateur  (voir  Figure  5­3  |  Menu  SERVICE  AMP)  est  accessible  depuis  l'écran  SÉLECTION  DE  MENU  
(voir  Figure  5­1  |  SÉLECTION  DE  MENU)  en  mode  RX  uniquement.

Les  fonctions  inactives  sont  grisées  et  les  fonctions  actives  sont  rouges.  Lorsqu'on  quitte  un  sous­menu  de  fonction,  celui­ci  est  
automatiquement  désactivé.  En  appuyant  sur  le  bouton  EXIT ,  toutes  les  fonctions  de  service  sont  désactivées  et  l'écran  de  SÉLECTION  
DU  MENU  réapparaît  (voir  Figure  5­1  |  SÉLECTION  DU  MENU).  En  appuyant  plusieurs  fois  sur  le  bouton  EXIT ,

Le  menu  AMP  SERVICE  permet  de  vérifier  et  de  régler  le  courant  de  drain  à  vide  (au  repos)  des  transistors  
finaux,  ainsi  que  de  tester  certaines  fonctions  et  circuits  de  l'amplificateur  lors  de  sa  maintenance.  Nous  
recommandons  de  confier  ces  opérations  à  un  technicien  qualifié !

5.2.  Menu  AMP  SERVICE  (Fonctions  de  service  de  l'amplificateur)

Août  2024

Manuel  d'utilisation  |  ACOM  1200S  |  Amplificateur  de  puissance  linéaire  1,8­54  MHz

Page  48  sur  94  |  Section  MENUS  ­  PARAMÈTRES  ET  OPTIONS

AVIS

Machine Translated by Google



Les  paramètres  CAT  ne  sont  accessibles  qu'en  mode  RX  (voir  Figure  5­1  |  SÉLECTION  DU  MENU  et  Figure  5­4  |  Menu  CAT/AUX

PARAMÈTRES.  La  sélection  d'un  élément  s'effectue  à  l'aide  des  boutons  ÉLÉMENT  et  ÉLÉMENT  (flèches  haut  et  bas).  La  valeur  est  définie  

à  l'aide  des  boutons  SÉLECTIONNER  et  SÉLECTIONNER  (flèches  gauche  et  droite).  Votre  sélection  apparaît  entre  crochets  [x]  à  l'écran.

Si  le  port  CAT  de  l'amplificateur  est  connecté  à  l'émetteur­récepteur  via  la  sortie  Données  de  bande  BCD  ou  Tension  de  bande,  sélectionnez  

le  type  d'interface  correspondant  sur  la  ligne  supérieure  et  appuyez  sur  le  bouton  EXIT .  Les  autres  éléments  et  valeurs  seront  ignorés  avec  

cette  sélection.

Si  le  câble  CAT  est  branché  sur  le  port  série  de  l'émetteur­récepteur,  sélectionnez  l'interface  et  le  jeu  de  commandes  conformément  au  

Tableau  5­1  |  Type  d'interface  et  sélection  du  jeu  de  commandes  de  l'émetteur­récepteur.  Le  débit  en  bauds  doit  être  identique  à  celui  de  

l'émetteur­récepteur.  L'espacement  des  octets  et  le  temps  d'interrogation  peuvent  rester  inchangés.

Une  fois  le  câble  CAT  connecté  entre  l'émetteur­récepteur  et  l'amplificateur,  les  paramètres  de  l'émetteur­récepteur  doivent  être  définis  via  ce  

menu.  En  l'absence  de  câble  CAT,  le  type  d'interface  doit  être  désactivé.

Figure  5­4  |  Menu  PARAMÈTRES  CAT/AUX

Figure  5­4  |  Menu  PARAMÈTRES  CAT/AUX

5.3.  Menu  PARAMÈTRES  CAT/AUX  (Sélection  de  l'interface  CAT/AUX)

Sélectionnez  enfin  le  type  d'interface  (RS­232  ou  TTL)  conformément  au  Tableau  5­1  |  Type  d'interface  de  l'émetteur­récepteur  et  sélection  du  

jeu  de  commandes  et  connexion  utilisée,  puis  appuyez  sur  le  bouton  EXIT  pour  revenir  à  la  SÉLECTION  DU  MENU.

S'il  n'y  a  pas  de  connexion  CAT,  mais  que  CAT  INTERFACE  est  sélectionné  (activé),  un  message  d'erreur  s'affichera  

lorsque  vous  changerez  de  bande.
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Sous  le  contrôle  de  l'interface  CAT,  l'amplificateur  suit  uniquement  les  changements  de  fréquence  du  VFO  « A ».

Les  tuners  d'antenne  automatiques  ACOM  04AT  et  06AT  suivent  la  fréquence  de  l'amplificateur.

Tableau  5­1  |  Type  d'interface  d'émetteur­récepteur  et  sélection  du  jeu  de  commandes

Tableau  5­1  |  Type  d'interface  d'émetteur­récepteur  et  sélection  du  jeu  de  commandes

Si  votre  émetteur­récepteur  possède  plusieurs  VFO,  et  qu'il  est  en  mode  SPLIT,  utilisez  le  VFO  « A »  pour  l'émission  et  

le  contrôle  du  tuner.  Si  la  fréquence  de  l'amplificateur  ne  change  pas  via  l'interface  CAT,  assurez­vous  d'utiliser  le  VFO  

« A »  sur  l'émetteur­récepteur,  car  l'interface  CAT  de  l'amplificateur  utilise  uniquement  les  données  du  VFO  « A ».
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RS­232

TTL 3

ÉLECTRICITÉ

Émetteur­récepteur Ensemble  de  commandes

ICOM  (Connexion  à  la  prise  REMOTE)

5

Interface

ICOM  (Connexion  au  port  RS­232  ou  CT17)

KENWOOD  TS­2000,  480,  590,  890,  990  et  similaires

RS­232

TTL 1

1RS­232

5

YAESU  FT­101,  450,  950,  991,  1200,  2000,  3000,  5000,  9000  et  similaires

YAESU  FT­1000MP

RS­232

2

YAESU  FT­817,  857,  897

4

RS­232
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b)  SORTIE  AUTOMATIQUE  DU  MENU

Lorsque  la  SORTIE  AUTOMATIQUE  DU  MENU  est  activée,  l'amplificateur  quitte  le  menu  actuellement  sélectionné  si  aucun  bouton  n'a  été  appuyé  pendant  plus  de  5  minutes.

Si  la  SORTIE  AUTOMATIQUE  DU  MENU  est  désactivée,  l'amplificateur  reste  dans  le  menu  actuellement  sélectionné  jusqu'à  ce  que  le  bouton  SORTIE  soit  enfoncé.

c)  FONCTIONNEMENT  AUTOMATIQUE

Figure  5­5  |  Menu  PRÉFÉRENCES  UTILISATEUR

a)  TUNER/COMMUTATEUR  D'ANTENNE  INSTALLÉ

Figure  5­5  |  Menu  PRÉFÉRENCES  UTILISATEUR

5.4.  Menu  PRÉFÉRENCES  UTILISATEUR

Le  paramètre  utilisateur  AUTO  OPERATE  est  décrit  dans  les  sections  3.3  Mise  sous  tension  initiale  et  4.1.c)  Paramètres  utilisateur  AUTO  OPERATE.

d)  INDICATIF  D'APPEL

Si  saisi  ici,  un  indicatif  d'appel  (ou  un  autre  texte)  sera  inclus  dans  le  fichier  journal  des  défauts  généré  par  l'amplificateur

(voir  Section  5.5  Menu  JOURNAL  DES  PANNES).  L'indicatif  d'appel  (ou  un  autre  texte)  ne  remplacera  pas  le  logo  ACOM  1200S  sur  l'écran  de  démarrage.

Utilisez  les  boutons  SELECT  et  SELECT  (flèches  gauche  et  droite)  pour  sélectionner  la  position  du  caractère.  Les  boutons  ITEM  et  ITEM  (flèches  haut  et  bas)  permettent  de  

changer  les  caractères.

Terminez  en  déplaçant  le  pointeur  hors  des  champs  modifiables  au  moyen  du  bouton  SELECT  (flèche  gauche).
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Les  autres  éléments  de  préférence  s’expliquent  d’eux­mêmes.

5.5.  Menu  JOURNAL  DES  DÉFAUTS

Cette  fonction  lit  à  l'écran  les  informations  stockées  en  mémoire  concernant  les  28  derniers  déclenchements  de  la  protection  DÉFAUT  MAJEUR  (voir  Figure  5­6  |  

Menu  JOURNAL  DES  DÉFAUTS).  En  appuyant  sur  le  bouton  FICHIER ,  les  informations  peuvent  également  être  téléchargées  au  format  texte  brut  via  le  port  

RS­232  et  un  ordinateur  utilisant  un  émulation  de  terminal  standard  (TTY).  Les  paramètres  du  protocole  RS­232  sont :  9600,  8,  N,  1,

Veuillez  consulter  la  section  7.4  Utilisation  des  codes  d'erreur  (signatures)  pour  les  diagnostics.

Lorsqu'il  est  verrouillé,  l'amplificateur  reste  en  veille  et  ne  peut  être  commuté  en  mode  FONCTIONNEMENT  que  s'il  est  déverrouillé  dans  le  même  menu.  Aucun  

mot  de  passe  n'est  utilisé ;  il  s'agit  simplement  d'une  protection  contre  d'éventuelles  actions  enfantines  ou  un  passage  involontaire  en  mode  FONCTIONNEMENT.  

Lorsqu'il  est  verrouillé,  toute  tentative  d'accès  en  mode  FONCTIONNEMENT  entraînera  un  message  d'erreur.

« LE  MODE  DE  FONCTIONNEMENT  EST  VERROUILLÉ »

message:

e)  EXPLOITER  L'ACCÈS

Figure  5­6  |  Menu  JOURNAL  DES  DÉFAUTS

Figure  5­6  |  Menu  JOURNAL  DES  DÉFAUTS
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Quatre  niveaux  de  réinitialisation  d'usine  différents  sont  disponibles  (voir  Figure  5­7  |  Menu  RESTAURER  LES  PARAMÈTRES  PAR  DÉFAUT).

Si  le  bouton  ACTION  (flèche  vers  le  haut)  est  enfoncé,  le  NON  est  à  nouveau  sélectionné  et  la  commande  ne  quittera  pas  la  position  actuelle.

Pour  confirmer  l'action  sélectionnée,  l'opérateur  doit  appuyer  à  nouveau  sur  le  bouton  ACTION  (flèche  vers  le  bas)  (confirmation  OUI).  Après  restauration  des  

paramètres  par  défaut,  la  commande  revient  à  l'écran  de  SÉLECTION  DU  MENU  (voir  Figure  5­1  |  SÉLECTION  DU  MENU).

5.6.  Menu  RESTAURER  LES  PARAMÈTRES  PAR  DÉFAUT

En  appuyant  sur  le  bouton  EXIT  dans  cette  position,  la  commande  quitte  ce  menu  sans  rien  changer  et  revient  à  la  fenêtre  précédente  (l'écran  MENU  SELECTION).

Figure  5­7  |  Menu  RESTAURER  LES  PARAMÈTRES  PAR  DÉFAUT

Figure  5­7  |  Menu  RESTAURER  LES  PARAMÈTRES  PAR  DÉFAUT
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Figure  6­1  |  Télécommande  Ethernet  ACOM  eBox

Le  fonctionnement  de  l'ACOM  1200S  avec  l'ACOM  eBox  est  décrit  dans  le  manuel  d'utilisation  de  l'ACOM  eBox.

Pour  plus  d'informations,  veuillez  consulter  notre  document

Si  vous  avez  besoin  de  schémas  de  câblage,  veuillez  consulter  notre  document

6.1.  Contrôle  à  distance  via  ACOM  eBox

Figure  6­1  Dispositif  de  contrôle  à  distance  Ethernet  ACOM  eBox

Le  contrôle  à  distance  de  l'ACOM  1200S  via  Internet  est  assuré  par  le  dispositif  de  contrôle  à  distance  Ethernet  ACOM  eBox.

La  télécommande  de  l'ACOM  1200S  est  assurée  soit  par  le  dispositif  de  télécommande  Ethernet  ACOM  eBox,  soit  par  le  port  RS­232.

L'utilisation  d'autres  appareils  de  télécommande  n'est  pas  recommandée.

6.2.  Télécommande  via  l'interface  RS­232

Pour  la  connexion  par  câble,  veuillez  consulter  la  section  2.5.b)  Connecteur  d'interface  RS­232  et  le  tableau  2­3  |  Signaux  et  brochage  du  connecteur  
RS­232.

Pour  le  protocole  d'interface  RS­232  ACOM  1200S,  veuillez  contacter  votre  revendeur  (voir  Section  1.9  Assistance  

au  propriétaire).

L'ACOM  1200S  peut  être  contrôlé  à  distance  via  le  port  RS­232.

•  Manuel  d'utilisation  de  l'ACOM  eBox.

•  Informations  techniques  sur  les  câbles  ACOM  CAT.

La  documentation  est  disponible  en  téléchargement  sur  www.acom­bg.com.

6.  TÉLÉCOMMANDE

La  documentation  est  disponible  en  téléchargement  sur  www.acom­bg.com.
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•  Filtre  à  air  PA  (module  amplificateur  de  puissance)

7.1.  Entretien  périodique

Nettoyez  les  filtres  à  air  périodiquement  et  plus  souvent  dans  un  environnement  poussiéreux,  mais  au  moins  une  fois  par  an.

Si  aucun  indicateur  ne  s'allume  lors  de  la  mise  sous  tension  de  l'amplificateur,  le(s)  fusible(s)  principal(aux)  peut(vent)  avoir  

grillé  (voir  Section  7.3  Remplacement  des  fusibles).

L'ACOM  1200S  dispose  de  deux  filtres  à  air.

Le  poids  de  l'appareil  est  d'environ  16  kg,  il  est  donc  préférable  qu'il  soit  manipulé  par  deux  personnes.

Vérifiez  régulièrement  le  ROS  des  antennes  et  observez  son  évolution.  Les  problèmes  peuvent  être  plus  fréquents  en  cas  de  mauvaises  conditions  

météorologiques  (pluie,  neige,  vent  fort,  etc.).

7.1.2.  Nettoyage  des  filtres  à  air

Pour  votre  sécurité,  débranchez  la  fiche  d'alimentation  de  l'amplificateur  de  la  prise  secteur  et  ATTENDEZ  AU  MOINS  3  

minutes  À  CHAQUE  FOIS  AVANT  de  retirer  le  couvercle  de  l'amplificateur.

C14)  Prise  de  courant  et  2.4.h)  Préparation  de  la  prise  murale.  En  cas  de  doute,  consultez  un  électricien  qualifié.

(voir  Figure  7­1  |  Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air,  Pos.  (2));

La  tension  secteur  et  la  haute  tension  continue  jusqu'à  500  V  à  l'intérieur  de  l'amplificateur  ACOM  1200S  sont  MORTELLES !

Portez  une  attention  particulière  à  la  fiche  secteur  et  à  la  prise  murale  (voir  sections  2.4.g)  La  norme  IEC  320­C14  (IEC  60320­

­  Utilisez  un  tournevis  cruciforme  n°1  pour  dévisser  les  4  vis  de  montage

Vérifiez  l'intégrité  des  câbles,  notamment  lorsqu'ils  sont  posés  au  sol.  Vérifiez  également  leur  bonne  fixation  à  leur  sortie  du  connecteur.

Veuillez  consulter  la  figure  7­1  |  Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air,  Pos.  (1).

Pour  retirer  le  filtre  à  air  PA :

Vérifiez  périodiquement  (mais  au  moins  une  fois  par  an)  toutes  les  connexions,  la  propreté  des  contacts  et  le  serrage  de  tous  les  connecteurs,  en  

particulier  ceux  coaxiaux.

7.1.1.  Contrôles  périodiques
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Pour  retirer  le  filtre  à  air  PS :

Pour  votre  sécurité,  débranchez  la  fiche  d'alimentation  de  l'amplificateur  de  la  prise  secteur  et  ATTENDEZ  AU  MOINS  3  

minutes  À  CHAQUE  FOIS  AVANT  de  retirer  le  couvercle  de  l'amplificateur.

La  tension  secteur  et  la  haute  tension  continue  jusqu'à  500  V  à  l'intérieur  de  l'amplificateur  ACOM  1200S  sont  MORTELLES !

Figure  7­1  |  Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air

corps  de  

l'amplificateur  (voir  Figure  7­1  |  Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air),  Pos.  (4)  et  Figure  7­3  |  Vue  de  dessous  de  

l'amplificateur  ­  filtre  à  air  PS  ouvert).

­  À  l'aide  d'un  petit  tournevis  plat  ou  d'une  pince  à  épiler,  soulevez  délicatement  le  plateau  du  filtre  pour  le  retirer  du

Figure  7­1  |  Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air

•

Veuillez  consulter  la  figure  7­1  |  Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air,  Pos.  (4).

­  Utilisez  un  tournevis  cruciforme  n°  1  pour  dévisser  les  2  vis  de  montage  (voir  Figure  7­1  |  

Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air,  Pos.  (5)) ;

Filtre  à  air  PS  (module  d'alimentation)

(voir  Figure  7­2  |  Couvercle  supérieur  de  l'amplificateur  retiré  ­  Filtre  à  air  PS,  Pos.  (1  et  2));

­  Retirez  délicatement  le  filtre  en  plastique  en  forme  de  mousse.

­  Utilisez  un  tournevis  cruciforme  n°1  pour  dévisser  les  2  vis  de  montage

­  Retirez  le  capot  supérieur  de  l'amplificateur  (non  représenté  ici) ;

­  Retirez  le  couvercle  du  filtre  carré  (voir  Figure  

7­1  |  Vue  de  dessous  de  l'amplificateur  ­  Filtres  à  air,  Pos.  (3)) ;
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Figure  7­3  |  Vue  de  dessous  de  l'amplificateur  ­  filtre  à  air  PS  ouvert

Figure  7­3  |  Vue  de  dessous  de  l'amplificateur  ­  filtre  à  air  PS  ouvert

Figure  7­2  |  Couvercle  supérieur  de  l'amplificateur  retiré  ­  Filtre  à  air  PS

Figure  7­2  |  Couvercle  supérieur  de  l'amplificateur  retiré  ­  Filtre  à  air  PS
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Figure  7­4  |  Filtre  à  air  PS

Enfin,  montez  les  filtres  à  air  en  place  dans  l'ordre  inverse  décrit  ci­dessus  et  serrez  fermement  les  vis.

Maintenant,  nettoyez  soigneusement  les  filtres  et  les  couvercles  de  la  poussière,  lavez­les  à  l'eau  du  robinet  et  laissez­les  sécher.

Figure  7­4  |  Filtre  à  air  PS

Les  filtres  à  air  sont  peut­être  trop  poussiéreux ;  veillez  à  les  nettoyer  avec  précaution  afin  de  NE  PAS  
INHALER  (RESPIRER)  ni  renverser  la  poussière !  Enveloppez­les,  par  exemple,  dans  un  chiffon  humide  avant  
de  les  nettoyer !
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Littelfuse,  PN :  0217010.H  (cartouche  à  corps  en  verre) ;

Si  le  remplacement  des  fusibles  est  nécessaire,  débranchez  d'abord  la  fiche  secteur  de  l'amplificateur  de  la  prise  secteur  et  
attendez  au  moins  3  minutes !

7.2.  Nettoyage

Ce  fusible  peut  être  commandé  auprès  de :

Pour  le  remplacement,  utilisez  uniquement  des  fusibles  standard  des  types  recommandés  ci­dessous.

N'utilisez  pas  de  solvants  pour  le  nettoyage.  Ils  peuvent  être  dangereux  et  endommager  les  surfaces  de  l'amplificateur,  la  

peinture  et  les  composants  en  plastique.

­  DigiKey  (www.digikey.com),  réf. :  0217010.MXBP­ND ;  ­  Farnell  

(www.farnell.com),  réf. :  1191761 ;

­  Mouser  (www.mouser.com),  référence :  576­0217010.

N'ouvrez  pas  l'amplificateur.  Le  nettoyage  des  surfaces  extérieures  peut  être  effectué  avec  un  chiffon  doux  en  coton  légèrement  humidifié  à  l'eau  claire.

Nettoyez  également  (autant  que  possible  de  l'extérieur,  sans  ouvrir  l'amplificateur)  toutes  les  ouvertures  de  ventilation  du  capot  et  du  châssis,  y  compris  

celles  du  bas.

Les  deux  fusibles  principaux  de  l'amplificateur  sont  situés  sur  le  panneau  arrière  (voir  Figure  2­4  |  Panneau  arrière  ­

Connexions,  Pos.  (f)).  Il  s'agit  de  fusibles  de  type  « F »  (à  action  rapide),  de  taille  européenne  5x20 mm,  à  cartouche  en  céramique  (ou  en  verre).

Les  fusibles  doivent  être  dimensionnés  pour :

Ne  poussez  jamais  et  n'introduisez  rien  dans  les  trous  du  boîtier  ­  cela  provoquerait  un  choc  électrique.

Un  fusible  10  A  approprié  est :

7.3.  Remplacement  du  fusible
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Ne  remplacez  pas  les  fusibles  internes  situés  à  l’intérieur  de  l’amplificateur.

Le  remplacement  des  fusibles  internes  est  une  opération  complexe  et  potentiellement  dangereuse.

Pour  cette  raison,  nous  recommandons  que  ces  travaux  soient  effectués  uniquement  par  un  technicien  de  service  qualifié.

Le  remplacement  non  autorisé  des  fusibles  intérieurs  viole  les  conditions  de  garantie !

Contactez  votre  revendeur  ACOM  pour  obtenir  de  l'aide  (voir  la  section  1.9  Assistance  au  propriétaire).

Des  fusibles  internes  grillés  peuvent  être  le  symptôme  d'un  problème  plus  grave,  qui  doit  être  résolu  au  préalable.  Un  tel  

défaut  ne  se  produit  pas  dans  des  conditions  de  fonctionnement  normales.

Outre  les  fusibles  primaires,  il  existe  des  fusibles  internes  à  l'intérieur  de  l'amplificateur.

Si,  après  le  remplacement  des  fusibles  principaux,  l'appareil  ne  fonctionne  pas  normalement,  nous  recommandons  une  

réparation,  effectuée  uniquement  par  un  technicien  de  service  qualifié.

Outre  plusieurs  normes  nationales  spécifiques,  la  principale  norme  sur  les  fusibles  appliquée  dans  le  monde  entier  est  la  
norme  IEC  60127.

Contactez  votre  revendeur  ACOM  pour  obtenir  de  l'aide  (voir  la  section  1.9  Assistance  au  propriétaire).
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•  Une  tension  de  8  à  15  V  CC  est  appliquée  à  l'entrée  « Mode  DEBUG »  (voir  Tableau  2­2  |  Signaux  et  brochage  du  connecteur  CAT/

AUX)  du  port  CAT/AUX.  L'alimentation  doit  pouvoir  fournir  un  courant  de  0,4  A ;

Si  la  carte  de  contrôle  a  déjà  été  retirée  de  l'amplificateur,  elle  peut  être  alimentée  directement  avec  +5  V  (0,4  A)  et  le  journal  des  

défauts  téléchargé  via  le  port  RS­232.

En  mode  de  lecture  du  JOURNAL  DES  DÉFAUTS  (voir  Section  5.5  Menu  JOURNAL  DES  DÉFAUTS),  la  carte  de  contrôle  transmet  automatiquement  

les  données  de  la  mémoire  via  l'interface  RS­232  (voir  Section  2.5.b)  Connecteur  d'interface  RS­232).

Les  données  peuvent  être  téléchargées  depuis  la  mémoire  de  l'ACOM  1200S  via  le  port  RS­232  et  stockées  dans  un  fichier  informatique  même  si  

l'amplificateur  ne  peut  pas  être  allumé  après  une  panne  grave  ­  seule  une  alimentation  externe  doit  être  fournie  à  l'amplificateur.

Unité  de  contrôle  de  l'une  des  manières  suivantes :

Les  données  des  28  derniers  déclenchements  de  la  protection  HARD  FAULT  sont  stockées  dans  la  mémoire  de  l'amplificateur  (voir  Section  5.5  

Menu  FAULTS  LOG).

7.4.  Utilisation  des  codes  d'erreur  (signatures)  pour  le  diagnostic

Pour  décoder  les  données  hexadécimales  téléchargées,  vous  devez  utiliser  le  convertisseur  de  signatures  de  défauts  matériels  ACOM

Vous  pouvez  envoyer  le  fichier  enregistré  à  votre  revendeur  ou  à  ACOM  en  conséquence.

Selon  le  nombre  d'événements  d'erreur  enregistrés  en  mémoire,  la  transmission  peut  prendre  entre  0,5  et  12  secondes.  Une  pause  de  6  secondes  

suit,  puis  la  transmission  reprend.  Les  données  peuvent  être  lues  en  texte  clair  sur  un  ordinateur,  à  l'aide  d'un  émulateur  de  terminal  standard  (TTY).
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11.02.2017

­  Désactiver  le  fonctionnement  automatique  après  une  erreur  matérielle

Prise  en  charge  CAT  Yaesu  FT­991A  ajoutée ;

12.06.2021

Version  de  base  du  micrologiciel ;

26.06.2018

19.02.2024

2,5

Notes /  Résumé  des  modifications

Procédure  de  réglage  complet  de  l'ATU  améliorée ;

Ces  changements  sont  purement  internes  et  n’ont  aucun  effet  sur  l’expérience  de  l’utilisateur  final

Améliorations;

­  Augmenter  le  seuil  pour  5  V  max

11.02.2018

1.0

2.2

­  Améliorer  la  lisibilité  du  code  et  ajouter  une  division  HW  (ces  modifications  sont  purement  internes)

2.4

1.1

Sélection  de  bande  et  de  mode  d'interface  série  fixe ;

et  n'ont  aucun  effet  sur  l'expérience  de  l'utilisateur  final)

05.10.2017

1.4

09.03.2022

­  Correction :  sélection  de  l'heure  d'interrogation  et  de  l'espacement  des  octets

ATU  radié  fixe;

Communication  série  avec  le  PC  améliorée ;

Date  de  sortie

­  NOUVELLE  fonction :  « Protection  automatique  active »

­  Interface  CAT :  régler  correctement  la  puissance  avant  le  réglage

Problèmes  CAT  de  l'Elecraft  K3  résolus ;

Matériel  et  logiciel  révisés ;

20.03.2024 ­  Uniquement  les  modifications  du  code  interne

Version

1.3

2.1.2

­  Interface  YAESU  CAT :  restaurer  le  gain  du  micro  après  le  réglage
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Les  dernières  versions  du  firmware  de  nos  produits  sont  disponibles  sur  www.acom­bg.com  gratuitement.
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7.5.1.  Versions  du  micrologiciel

Tableau  7­1  |  Historique  des  versions  du  micrologiciel  de  l'ACOM  1200S

L'historique  des  versions  de  micrologiciel  du  module  CPU  ACOM  1200S  disponibles  est  présenté  dans  le  Tableau  7­1  |  Historique  des  versions  de  

micrologiciel  ACOM  1200S.

7.5.  Micrologiciel

Tableau  7­1  |  Historique  des  versions  du  micrologiciel  de  l'ACOM  1200S

Le  nouveau  firmware  est  publié  sous  forme  de  fichier,  par  exemple  ACOM_1200S_FW  V2.5  ­  20.03.2024.DAT.

Machine Translated by Google
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•  Port  RS­232  (port  réel /  intégré)  comme  indiqué  sur  l'image  ci­dessous :

Août  2024

Pour  télécharger  (ou  sauvegarder)  un  firmware  sur  l'ACOM  1200S,  vous  devez  utiliser  le  logiciel  ACOM  Terminal  S ,  distribué  
gratuitement  par  ACOM.  Vous  pouvez  le  télécharger  sur  www.acom­bg.com.
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ou  plus  récent.

La  version  2.5  du  firmware  ACOM  1200S  est  compatible  avec  tous  les  amplificateurs  ACOM  1200S  produits  (voir  

Section  1.4  Historique  du  produit  et  validité  de  la  documentation).

Le  terminal  ACOM  S  est  disponible  uniquement  pour  les  systèmes  d'exploitation  MS  Windows.

Le  terminal  ACOM  S  communique  avec  l'amplificateur  via  l'interface  RS­232.

Avant  de  modifier  la  version  du  firmware,  vérifiez  sa  compatibilité  avec  les  révisions  du  matériel  et  du  chargeur  de  

démarrage  de  votre  amplificateur  (voir  Figure  5­6  |  Menu  JOURNAL  DES  PANNES).  En  cas  de  doute  sur  les  versions,  

veuillez  consulter  votre  revendeur  avant  toute  intervention.

Nous  vous  recommandons  fortement  de  mettre  à  jour  votre  amplificateur  ACOM  1200S  avec  la  version  2.5  du  firmware

Lorsqu'ACOM  publie  une  nouvelle  version  du  firmware,  l'utilisateur  peut  la  télécharger  dans  l'amplificateur  après  avoir  vérifié  la  compatibilité.  

Une  fois  la  compatibilité  confirmée,  il  est  également  possible  de  revenir  à  une  version  antérieure.

7.5.2.  Conditions  préalables

Figure  7­5  |  Exemple  de  PC  avec  port  RS­232  (interface)

Pour  utiliser  l'  ACOM  Terminal  S,  vous  devez  installer  le  logiciel  sur  un  PC  équipé  de :

L'équipe  de  support  technique  d'ACOM  peut  vous  conseiller  sur  l'utilisation  du  Terminal  S  dans  l'environnement  
Windows.

Figure  7­5  |  Exemple  de  PC  avec  port  RS­232  (interface)
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http://www.acom-bg.com/


Panneau  arrière  de  l'ACOM  1200S Ordinateur  personnel

connecteur  RS­232
Câble  de  connexion

connecteur  RS­232

Figure  7­6  |  Exemples  de  convertisseurs  « USB  vers  RS­232 »

1  |  DCD

5  |  GND

8

4  |  Non  connecté

5

­

­

1

Logement

6  |  DSR

7  |  RTS

Logement

4

Logement

2

9  |  Non  connecté

­

3  |  TxD

6

1  |  Non  connecté
––––––––

3  |  RxD

2  |  TxD

7

4  |  DTR­

2  |  RxD

9

––––––––5  |  GND

6  |  DSR

­

Bouclier  extérieur

7  |  Non  connecté

2

8  |  CTS8  |  CTS

3

­

9  |  RI

5

3

Logement

––––––––

Tableau  7­2  |  Câblage  du  câble  de  connexion  RS­232

Figure  7­6  |  Exemples  de  convertisseurs  « USB  vers  RS­232 »

Tableau  7­2  |  Câblage  du  câble  de  connexion  RS­232

Pour  le  câble  de  connexion  RS­232  nécessaire,  voir  le  Tableau  7­2  |  Câblage  du  câble  de  connexion  RS­232.

De  nos  jours,  la  plupart  des  ordinateurs  ne  disposent  pas  d'interface  RS­232  intégrée.  Cependant,  tous  les  ordinateurs  disposent  

de  deux  ports  USB.  Dans  ce  cas,  vous  devez  utiliser  un  convertisseur  d'interface  USB  vers  RS­232.

OU

L'ACOM  recommande  d'utiliser  des  convertisseurs  « USB  vers  RS­232 »  produits  par  FTDI  
(www.ftdichip.com)  ou  basés  sur  une  puce  FTDI.

D­sub

(Vue  de  

face)

9  broches,  femelle

(Vue  de  la  soudure)

connecteur,

Convertisseur  USB  (connecteur  de  type  C)  vers  RS­232

9  broches,

D­sub

femelle

Convertisseur  USB  (connecteur  de  type  A)  vers  RS­232

mâle

D­sub

connecteur, connecteur,
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9  broches,

D­sub

9  broches,  mâle
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connecteur,

(Vue  de  la  soudure)

(Vue  de  

face)

•  Convertisseur  « USB  vers  RS­232 ».
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Non  connecté

Non  connecté

Non  connecté

Non  connecté

Blindage  du  câble
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Ce  convertisseur  peut  être  commandé  auprès  de :

Les  convertisseurs  « USB  vers  RS­232 »  appropriés  sont :

­  DigiKey  (www.digikey.com),  référence :  768­1085­ND ;  ­  TME  

(www.tme.eu),  référence :  UT232R­500 ;

La  procédure  de  mise  à  jour  du  firmware  ci­dessous  s'applique  à  un  PC  équipé  de  Windows  11  et  utilisant  un  

convertisseur  USB  vers  RS­232.  Le  PC  utilisé  possède  les  deux  interfaces  RS­232 :

­  Convertisseur  d'interface  « USB  vers  RS­232 »

FTDI,  PN :  UT232R­200  (USB  (connecteur  type  A)  vers  RS­232  (connecteur  D­sub,  9  broches,  mâle),  longueur  de  câble  de  2  m)

­  Mouser  (www.mouser.com),  référence :  895­UT232R­500 ;

­  Port/interface  série  RS­232  (intégré).

­  Farnell  (www.farnell.com),  PN :  2352014.

Les  exemples  d'images  ci­dessous  sont  basés  sur  le  logiciel  Terminal  S  utilisé  avec  un  amplificateur  ACOM  500S  connecté.  La  

procédure  de  mise  à  jour  du  firmware  est  identique  pour  les  amplificateurs  ACOM  700S  et  1200S.

Digitus,  PN :  DA­70166  (USB  (connecteur  type  C)  vers  RS­232  (connecteur  D­sub,  9  broches,  mâle),  longueur  de  câble  de  1  m)

­  DigiKey  (www.digikey.com),  référence :  768­1084­ND ;  ­  Mouser  

(www.mouser.com),  référence :  895­UT232R­200 ;

Ce  convertisseur  peut  être  commandé  auprès  de :

­  Farnell  (www.farnell.com),  référence :  2352013.

Ce  convertisseur  peut  être  commandé  auprès  de :

FTDI,  PN :  UT232R­500  (USB  (connecteur  type  A)  vers  RS­232  (connecteur  D­sub,  9  broches,  mâle),  longueur  de  câble  de  5  m)

­  TME  (www.tme.eu),  réf. :  DA­70166.

7.5.3.  Mises  à  jour  du  micrologiciel

•

•

•
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•  Accédez  au  Gestionnaire  de  périphériques  de  votre  PC  (clic  droit  sur  le  bouton  Démarrer  de  Windows  ­>  Gestionnaire  de  périphériques).  Le  pilote  

du  convertisseur  devrait  s'installer  automatiquement  et  vous  devriez  observer  une  situation  similaire  à  la  Figure  7­7  |  Gestionnaire  de  

périphériques  (si  l'installation  du  pilote  est  réussie).

Figure  7­7  |  Gestionnaire  de  périphériques  PC

et  ne  connectez  pas  le  convertisseur  à  l'amplificateur.

ÉTAPE  1  –  Paramètres  de  l'interface  RS­232  sur  votre  PC

Assurez­vous  que  le  pilote  correct  (le  plus  récent)  pour  votre  matériel  est  installé.

Figure  7­7  |  Gestionnaire  de  périphériques  PC

N'oubliez  pas  le  numéro  de  port  série  (RS­232).
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•  Allumez  votre  PC.  Connectez  le  convertisseur  USB  vers  RS­232  à  n'importe  quel  port  USB  de  votre  ordinateur.
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Figure  7­8  |  Gestionnaire  de  périphériques  PC  ­>  Propriétés  du  port

>  Propriétés).  Vous  pouvez  observer  une  situation  similaire  à  celle­ci :

Figure  7­8  |  Gestionnaire  de  périphériques  PC  ­>  Propriétés  du  port
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•  Accédez  aux  propriétés  du  port  série  (clic  droit  de  la  souris  sur  Gestionnaire  de  périphériques  ­>  Ports  ­>  Port  série  USB  ­
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Figure  7­9  |  Gestionnaire  de  périphériques  PC  ­>  Propriétés  du  port  série  USB

Redémarrez  votre  PC

Figure  7­9  |  Gestionnaire  de  périphériques  PC  ­>  Propriétés  du  port  série  USB

•  Accédez  à  l’onglet  Paramètres  du  port  ­>  onglet  Avancé  et  modifiez  le  paramètre  Minuterie  de  latence  sur  1  ms.

Figure  7­10  |  Redémarrer  le  PC  Windows

Figure  7­10  |  Redémarrer  le  PC  Windows

•
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onglet  ­>  onglet  Avancé  et  modifiez  les  paramètres  du  tampon  de  réception/transit  sur  1.

Figure  7­11  |  Exemples  Gestionnaire  de  périphériques  PC  ­>  Propriétés  du  port  RS­232  intégré

Veuillez  noter  que  ces  paramètres  dépendent  du  type/modèle  de  matériel  de  votre  port  RS­232  intégré  et  peuvent  être  différents  de  
l'exemple  ci­dessous.

Si  vous  utilisez  un  PC  avec  un  port  RS­232  intégré,  l'  ÉTAPE  1  ci­dessus  est  similaire  et  vous  devez  accéder  aux  paramètres  du  port.

Figure  7­11  |  Exemples  Gestionnaire  de  périphériques  PC  ­>  Propriétés  du  port  RS­232  intégré

Août  2024
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DANGER

émetteur­récepteur,  antennes,  etc.

ÉTAPE  2  –  Paramètres  de  l'amplificateur

­

­

•  Lorsque  l'amplificateur  est  allumé,  appuyez  sur  le  bouton  POWER  pour  éteindre  l'amplificateur  (retour  au  mode  veille  basse  

consommation) ;

Retirez  la  connexion  GND  en  dernier  (voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (a))  et  attendez  30  minutes  

par  mesure  de  sécurité.

Figure  7­12  |  Panneau  arrière  –  Port  RS­232

•  Éteignez  l'amplificateur  via  l'interrupteur  à  bascule  d'alimentation  principal  (voir  Figure  2­4  |  Panneau  arrière  ­

Insérez  la  fiche  secteur  de  l’amplificateur  dans  la  prise  murale ;

Connexions,  Pos.  1) ;  Assurez­vous  que  l'interrupteur  à  bascule  d'alimentation  principal  est  en  position  OFF ;

Retirez  la  fiche  secteur  de  l’amplificateur  de  la  prise ;

Figure  7­12  |  Panneau  arrière  –  Port  RS­232

(voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  1) ;

•  Ne  déconnectez  pas  la  connexion  GND ;

Si  votre  PC  dispose  d'un  port  RS­232  intégré,  vous  devez  utiliser  un  câble  RS­232  (voir  Tableau  7­2  |  Câblage  du  

câble  de  connexion  RS­232)  pour  connecter  un  amplificateur  au  PC.

Si  votre  ordinateur  ne  dispose  pas  d'une  interface  série  RS­232  intégrée,  utilisez  un  convertisseur  « USB  vers  

RS­232 »  (voir  Figure  7­6  |  Exemples  de  convertisseurs  « USB  vers  RS­232 »).

•  Débranchez  tous  les  câbles  (sauf  la  connexion  GND )  du  panneau  arrière  de  l'amplificateur  –

•  Connectez  l'amplificateur  au  PC  via  l'interface  RS­232  sur  le  panneau  arrière  de  l'amplificateur  (voir

•  Vérifiez  si  l'interrupteur  à  bascule  du  panneau  arrière  (marqué  ON/OFF)  est  éteint  (doit  l'être).

•
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•  Allumez  l'amplificateur  via  l'interrupteur  à  bascule  d'alimentation  principal
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• Push and hold for 1-2 seconds the POWER button to start the amplifier and enter STANDBY 
mode. 

 
 

If the amplifier starts normally there will be a couple of beeps from the amplifier. 

 
 
 
STEP 3 – Using Terminal S software for Firmware Update 
 

• Exit all programs running on your computer and DISABLE/DEACTIVATE any antivirus software; 

• Start ACOM Terminal S software (We assume that you downloaded Terminal S software from 
www.acom-bg.com and installed it on your PC); 

 
Figure 7-13 | ACOM Terminal S screenshot 

 
 

Figure 7-13 | ACOM Terminal S screenshot 
 
 

• Open the Settings window by clicking on the Settings icon (two gears) or use Tools -> Settings 
from the menu bar. In the Settings window -> tab General, configure the settings as shown in 
Figure 7-14 | Terminal S - Tools -> Setting -> General menu: 

- Command timeout (ms)  10000; 

• In the Settings window -> tab Serial port, configure the settings as shown in Figure 7-15 | 

Terminal S - Tools -> Setting -> Serial port menu. For actual serial port number see STEP 1 – RS-232 

Interface Settings on your PC: 

- Serial port settings  9600, 8, None, 1; 
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Figure 7-14 | Terminal S - Tools -> Setting -> General menu 

 
 

Figure 7-14 | Terminal S - Tools -> Setting -> General menu 
 

Figure 7-15 | Terminal S - Tools -> Setting -> Serial port menu 

 
 

Figure 7-15 | Terminal S - Tools -> Setting -> Serial port menu 
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• Connect ACOM Terminal S to the amplifier by clicking on the Connect icon (two connected 
plugs) or use Device -> Connect from the menu bar; 
 

Figure 7-16 | Terminal S - Connect to amplifier 

 
 

Figure 7-16 | Terminal S - Connect to amplifier 
 

 

• When connected click on the Firmware Upload/Download icon (two arrows in opposite 
directions) or use Device -> Firmware upload/download from the menu bar to activate the 
Bootloader; 

 

Figure 7-17 | Terminal S - Firmware Upload/Download 

 
 

Figure 7-17 | Terminal S - Firmware Upload/Download 
 

 

When the bootloader has been activated there will be beeps from the amplifier and the 
front display will go black. 
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• Click on the Disconnect icon (two separated plugs) or use Device -> Disconnect from the menu 
bar to disconnect from the amplifier. 

 

Figure 7-18 | Terminal S - Disconnect 

 
 

Figure 7-18 | Terminal S - Disconnect 
 

 

• Open the Settings window by clicking on the Settings icon (two gears) or use Tools -> Settings 
from the menu bar. In the Settings window -> tab Serial port, configure the settings as shown 
in Figure 7-19 | Terminal S - Change Bits per Second: 

- Serial port settings  34800, 8, None, 1 
(change "Bits per second" parameter only); 

 
Figure 7-19 | Terminal S - Change Bits per Second 

 
 

Figure 7-19 | Terminal S - Change Bits per Second 
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• Re-connect to the amplifier by clicking on the Connect icon (two connected plugs) or use 
Device -> Connect from the menu bar; 
 

Figure 7-20 | Terminal S - Reconnect 

 
 

Figure 7-20 | Terminal S - Reconnect 
 
 

• When connected click on the Firmware Upload/Download icon (two arrows in opposite 
directions) or use Device -> Firmware upload/download from the menu bar to activate the 
bootloader. A Bootloader menu will appear in the text box as shown below; 

 

Figure 7-21 | Terminal S - Bootloader menu 

 
 

Figure 7-21 | Terminal S - Bootloader menu 
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• Press the U letter from your keyboard to activate the Firmware Upload process. 
Press the Y letter from your keyboard to answer the question that appears: 

 

CURRENT FIRMWARE WILL BE ERASED! ARE YOU SURE (N/N)? 
 

A new dialog box will open asking for the new firmware file name and location. Open the folder 
that contains the new firmware file (*.dat), select the file, and press the Upload button (We 
assume that you downloaded the newest firmware from www.acom-bg.com and unzipped it on 
your PC); 

 

Figure 7-22 | Terminal S - Upload firmware process 

 
 

Figure 7-22 | Terminal S - Upload firmware process 
 
 
The Upload firmware process may take approx. 3-6 minutes.  
 

 

During the Firmware Update Process, the user's amplifier settings are kept and are 
available in the new firmware version. 
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• Press the B letter from your keyboard to activate the Firmware Backup process. 
A new dialog box will open prompting you to enter a name and location for the new backup 
file. Press the Download button to start the process; 

 

Figure 7-23 | Terminal S - Backup firmware process 

 
 

Figure 7-23 | Terminal S - Backup firmware process 
 
 
The Backup firmware process may take approx. 3-6 minutes.  
 
 

It is not obligatory to back up your current firmware because all firmware versions are 
available for download from www.acom-bg.com. 

 
 

http://www.acom-bg.com/
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• Press the E letter from your keyboard to exit from the process. Click on the Disconnect icon 
(two separated plugs) or use Device -> Disconnect from the menu bar to disconnect from the 
amplifier. Click on the File -> Quit from the menu bar to close Terminal S; 

 
Figure 7-24 | Terminal S - Exit process 

 
 

Figure 7-24 | Terminal S - Backup firmware process 
 
 

• Push and hold for 1-2 seconds the POWER button to restart the amplifier and enter STANDBY 
mode. 
You can check the current firmware version in the amplifier's menu FAULT LOG (see Section 
5.5 Menu FAULTS LOG); 

 
• Push the POWER button to turn off the amplifier (back to low energy STANDBY mode); 

 

• Switch off the amplifier via Main Power Rocker Switch (see Figure 2-4 | Rear panel - 

Connections, Pos. 1); Make sure the Main Power Rocker Switch is in OFF position; 
 

• Pull the line (mains) plug out of the outlet; 
 

• Disconnect "USB to RS-232" converter or RS-232 cable; 
 

• Follow the instructions in Section 2.4 Connections to re-connect the amplifier to your station. 
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7.5.4. Troubleshooting 
 
Sometimes the procedure for Firmware Update/Backup is unsuccessful. 
 
A. Error Timeout when using Terminal S software  

If you see an error message related to Timeout, please check: 

• Latency Timer parameter as describer in Section 7.5.3 Firmware Updates    
(STEP 1 – RS-232 Interface Settings on your PC); 

 
Figure 7-25 | Terminal S - Error Timeout 

 

 
 

Figure 7-25 | Terminal S - Error Timeout 
 
 

• If using a PC with a built-in RS-232 port: 

- Check Receive/Transit buffer parameters as described in Section 7.5.3 Firmware 

Updates  (STEP 1 – RS-232 Interface Settings on your PC); 

- Check the used connection cable. See Table 7-2 | RS-232 connection cable wiring for 
correct cabling; 

 
• Command timeout parameter as describer in Section 7.5.3 Firmware Updates   

(STEP 3 – Using Terminal S software for Firmware Update). 
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The other possible reasons for Timeout error could be, for example: 

• Windows Device Manager -> USB Serial Converter Properties -> Advanced 
Below are shown the recommended settings (VCP = Virtual Com Port):   

 
Figure 7-26 | Windows Device Manager - Load VCP 

 
 

Figure 7-26 | Windows Device Manager - Load VCP 
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• Windows Device Manager -> USB Serial Converter Properties -> Power Management 
Below are shown the recommended settings:   

 
Figure 7-27 | Windows Device Manager - Power Management 

 
 

Figure 7-27 | Windows Device Manager - Power Management 
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• Windows Power plan 
Below are shown the recommended settings:   

 
Figure 7-28 | Windows Control Panel - Power plan 

 
 

Figure 7-28 | Windows Control Panel - Power plan 
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B. If, for some reason (mostly human error), the Firmware Update/Backup process is interrupted, the 
following scenarios are possible: 

 
• The amplifier is in STANDBY mode (the monitor shows the user interface) but nothing happens 

when you press the Terminal S buttons. 

Solution: 

- Click on the Disconnect icon (two separated plugs) to disconnect from the amplifier; 

- Click on the File -> Quit from the menu bar to close Terminal S; 

- Push and hold for 1-2 seconds the POWER button to shut down the amplifier; 

- Power up the amplifier again; 

- Start Terminal S; 

- Start the Firmware Update procedure from the beginning. 
 

• The amplifier's monitor is black/no image (BOOTLOADER mode) but nothing happens when you 
press the Terminal S buttons. 

Solution: 

- Click on the Disconnect icon (two separated plugs) to disconnect from the amplifier; 

- Click on the File -> Quit from the menu bar to close Terminal S; 

- Push and hold for 1-2 seconds the POWER button to shut down the amplifier; 

- Power up the amplifier again; 

o If the amplifier starts normal and goes to STB mode, then: 

▪ Start the Terminal S and continue with the Firmware Update 
procedure from the beginning; 

o If the amplifier starts with a black monitor (BOOTLOADER mode), then start 
the Terminal S and change Serial port settings to 38400, 8, None, 1; 

▪ Connect to the amplifier by clicking on the Connect icon (two 
connected plugs); 

▪ Click on the Firmware Upload/Download icon (two arrows in opposite 
directions) to activate the bootloader. A bootloader menu should now 
appear in the text box; 

▪ Continue with the Firmware Update procedure as usual. 
 
 

If the problem persists, contact your dealer (see Section 1.9 Owner Assistance). 
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8. SPECIFICATIONS 
 

8.1. Parameters  
 

a) Standard Frequency Coverage 

1.800 - 2.000 MHz (160 m band) 

3.500 - 4.000 MHz (80 m band) 

5.020 - 5.455 MHz (60 m band)* 

7.000 - 7.300 MHz (40 m band) 

10.100 - 10.150 MHz (30 m band) 

14.000 - 14.350 MHz (20 m band) 

18.068 - 18.168 MHz (17 m band) 

21.000 - 21.450 MHz (15 m band) 

24.890 - 24.990 MHz  (12 m band) 

28.000 - 29.700 MHz (10 m band) 

50.000 - 54.000 MHz (6 m band)*  
  
 

*  Please, refer the applicable regional band plans and laws for specific allocations and 
limitations. 

In specific business cases, extensions or changes of the frequency coverage can be 
discussed, but this must be agreed upon before ordering. In any case, this is not the 
producer's obligation and can not be against local rules and laws. 

 
 

b) Rated Output Power 

• 1000 W ±0.5 dB, PEP or continuous carrier, without mode limitation; 
 
 

NOTICE 

You will have to reduce the output power to about 500 W in order to keep the mains 
current consumption below 10 A if the amplifier is operated at below 200 VAC mains 
supply voltage. 

 
 

c) Intermodulation Distortions (IM3) 

• Better than 31 dB below rated PEP; 
 

d) Harmonic and Parasitic Emissions Output Suppression 

• Better than 60 dB (65 dB typically); 
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e) Input and Output Impedances 

• Nominal value: 50 Ohm unbalanced, UHF (SO-239) type connectors; 

• Input circuit: Broadband, SWR below 1.2 (1.1 typically), 1.8-54 MHz continuous range 
without retuning or switching; 

• RF bypass path SWR - below 1.1, 1.8-54 MHz; 

• Acceptable SWR at the output load (the antenna): up to 3 with proportional power 
reduction and up to 1.5 for full output power; 

 
f) RF power gain 

• 14 dB ±1 dB (typically 40 W for 1000 W output power); 
 

g) Mains Power Supply Voltage 

• 100-240 VAC (switching-mode power supply), 50-60 Hz, Single phase; 
• Below 200 VAC the output power is reduced to 500 W; 
 

h) Mains Power Consumption at Full Output Power 

• Power factor of 0.95 or higher; 

• Up to 2100 VA at rated output from 200/240 VAC mains supply; 

• Up to 1100 VA at 500 W output from 100/120 VAC mains supply; 
 

i) Mains Power Consumption in Low Energy (Waiting) Mode 

• Less than 1 VA; 
 

j) Receive / transmit control 

• KEY-IN input - Phono RCA jack. 

- Voltage applied to the transceiver keying output - up to +12 V; 
- Closed-circuit current flown to the transceiver keying output - up to 6 mA; 

• KEY-OUT output - open-drain, Phono RCA jack. 

- Output resistance: not more than 120 Ohm; 
- Maximum allowable open-circuit voltage coming from transceiver connection: +50V; 
- Maximum allowable closed-circuit current flown by the transceiver: 20 mA; 

• Minimum dead time, necessary for safe amplifier switching over from receive to transmit: 
10 ms between the transmit request on the KEY-IN input and the RF drive on the RF 
INPUT jack. 

 
k) Safety and Electromagnetic Compatibility 

• Complies with CE safety and electromagnetic compatibility requirements, as well as with 
the US Federal Communications Commission (FCC) regulations; 

 
l) Size & Weight (operating, excluding connected cables and opened tilt foot bar) 

• WxDxH: 372x418x162 mm, 16.0 kg (14.7x16.5x6.4 inches, 35.3 lbs.); 
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m) Operating Environments 

• Temperature range: -10 to +40 degrees Celsius (14 oF to 104 oF); 

• Relative air humidity: up to 95% @ 35 degrees Celsius (95 oF); 

• Height above sea level: up to 3050 m (10000 ft) without output deterioration. 
 
 

8.2. Functions 
 

a) Frequency control directly by CAT from the transceiver 
 
b) Remote control through ACOM eBox Ethernet Remote Control device or via RS-232 interface 

 
c) Remote POWER ON by DSR/DTR and CTS/RTS lines on the RS-232 port or by ACOM eBox 

Ethernet Remote Control device 

 
d) Remote POWER ON / TURN OFF by DC voltage impulse or continuous DC voltage on CAT/AUX 

port ON_RMT input. 
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8.3. Regulatory Requirements 
 

a) European conformity 
 

   

 CE mark (Conformitè Europëenne) 

This symbol explains that "CE" marked ACOM product meets the 
essential requirements of the Radio Equipment Directive, 
2014/53/EU, and the restriction of the use of certain hazardous 
substances in electrical and electronic equipment Directive, 
2011/65/EU. 

 
 

b) US Federal Communications Commission (FCC) regulations  
 
FCC ID: 2AJXZ1200S  FCC ID number 

The FCC ID number explains that market ACOM product complies 
with the US Federal Communications Commission (FCC) 
regulations. 

 
 

The FCC ID number can be checked at 
www.fcc.gov/oet/ea/fccid. 
 
FCC ID numbers consists of two elements: 

 - А grantee code (for example 2AJXZ), and 

 - Аn equipment product code (for example 1200S). 
 
 

c) RF Exposure Information 
 

 WARNING 

Using the ACOM 1200S amplifier, antennas must be operated at certain minimum 
distance between the radiator and any person's body. 

 
 

This unit (ACOM 1200S amplifier) complies with the FCC RF Exposure limits for an 
uncontrolled environment. 

 
 

To comply with CFR Title 47 Part 97.13(C) and the Guidelines and Limits for Human 
Exposure to RF electromagnetic fields adopted by the FCC, you should evaluate your Radio 
Station Facilities as described in OET BULLETIN 65 plus SUPPLEMENT B - Additional 
Information for Amateur Radio Stations. 

http://www.fcc.gov/oet/ea/fccid
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OET BULLETIN 65 plus SUPPLEMENT B can be found at: 

 • https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65.pdf; 
 • https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65b.pdf. 

 
 
In addition to the above guidelines, please, see Section 3.6.f) Elimination of electromagnetic compatibility (EMC) 

problems. 
 
 
 

https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65.pdf
https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65b.pdf
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8.4. Storage and Shipment 
 

8.4.1. Storage Environment 
 
The amplifier may be kept packed in a dry, ventilated and unheated location (with no chemically active 
substances such as acids or alkalis) within the following environment ranges: 

• Temperature range: -40 to +70 degrees Celsius (-40 oF to 158 oF); 

• Humidity: up to 75% @ +35 degrees Celsius (95 oF). 
 
8.4.2. Shipping Size and Weight 
 
• WxDxH: Approx. 620x580x380 mm, 20.0 kg (24.5x22.9x15.0 inches, 44.1 lbs.). 

 
 

Please, contact ACOM (see 1.9 Owner Assistance) for shipment details. 

 
 

Figure 8-1 | Packaging cardboard box 

 
 

Figure 8-1 | Packaging cardboard box 
 
 

8.4.3. Transportation 
 

All types of transportation may be used, including storage in an aircraft baggage compartment at up to 
12000 meters (40000 ft) above sea level. 
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8.4.4. Returning to the Service Provider 
 
This document section contains the general information on packing and shipping an amplifier for 
diagnostics and repair. 
 
 

NOTICE 

Should it be necessary to ship the amplifier, use the original packing as described below. 
 
 

NOTICE 

Before shipping the amplifier, you should contact your local dealer first. 

Your dealer can have a specific shipment requirement, e.g., a different shipping address. 
It is the sole customer's responsibility to ensure the commutator and all accessories are 
properly packaged to avoid any shipping damage. 

 
 

If transporting for diagnostics and repair, you may not need to ship some cables or 
accessories. Please, consult with your dealer first. 

 
 
Prepare the amplifier for shipping as described below: 

• Switch off the amplifier via Main Power Rocker Switch (see Figure 2-4 | Rear panel - Connections, 

Pos. 1); Make sure the Main Power Rocker Switch is in OFF position; 

• Pull the amplifier's line (mains) plug out of the outlet; 

• Do not disconnect GND connection; 

• Disconnect all cables (except GND connection) from the rear panel of the amplifier; 
 

 

 DANGER 

Remove the GND connection last (see Figure 2-4 | Rear panel - Connections, Pos. (a)) and 
wait 30 minutes for safety.  

 

 

• Pack the amplifier in its original cardboard carton. Please, follow the instructions in section 
2.1 Unpacking and Initial Inspection but in reverse order; 

• Seal the amplifier carton with heavy duty, 2-inch-wide self-adhesive tape; 

• Finally, the external strapping needs to be added over the amplifier carton. Either plastic or 
metal bands can be used; 

• Now, the amplifier is ready for shipment. 
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Basic shipping insurance is provided by the customer when sending in an amplifier - you 
can verify the amount covered by the shipping company by looking on their website. If 
you are shipping the amplifier, full/upgraded coverage is available as a suggested 
option. 

 
 

For alternative shipping instructions, please, contact your local dealer. 
 

 
 

8.5. Information on Disposing and Recycling of Old Electrical and Electronic Equipment 
 

The information in this section is applicable for countries that have adopted separate 
waste collection systems. 

 
 
ACOM products cannot be disposed as household waste. 
 
 

   

 

Waste electricals 
 
This symbol (crossed-out wheeled bin) explains that you should not 
place the electrical item in the general waste.  

 
 

   

 Waste electricals 
 
This symbol (three green arrows going in a triangle with electrical 
plug in the center) means that according to local laws and 
regulations this product should be sent for recycling.  

 
 
 
Old electrical and electronic equipment and batteries should be recycled at a facility capable of handling these 
items and their waste byproducts. 
 
Contact your local authority for details in locating a recycle facility nearest to you. 
 
Proper recycling and waste disposal will help conserve resources whilst preventing detrimental effects on our 
health and the environment. 
 
 

Ultimate disposal of this product should be handled according to all national laws and 
regulations. 
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Si  l'amplificateur  démarre  normalement,  il  émettra  quelques  bips.

Depuis  la  barre  de  menus.  Dans  la  fenêtre  Paramètres  ­>  onglet  Général,  configurez  les  paramètres  comme  indiqué  dans  la  Figure  

7­14  |  Terminal  S  ­  Outils  ­>  Paramètres  ­>  Menu  Général :

•  Ouvrez  la  fenêtre  Paramètres  en  cliquant  sur  l'  icône  Paramètres  (deux  engrenages)  ou  utilisez  Outils  ­>  Paramètres

Figure  7­13  |  Capture  d'écran  du  terminal  S  d'ACOM

mode.

­ 9600,  8,  Aucun,  1;

Figure  7­13  |  Capture  d'écran  du  terminal  S  d'ACOM

Appuyez  et  maintenez  enfoncé  pendant  1  à  2  secondes  le  bouton  POWER  pour  démarrer  l'amplificateur  et  passer  en  mode  veille

Paramètres  du  port  série

Démarrez  le  logiciel  ACOM  Terminal  S  (nous  supposons  que  vous  avez  téléchargé  le  logiciel  Terminal  S  depuis  www.acom­bg.com  

et  que  vous  l'avez  installé  sur  votre  PC) ;

Dans  la  fenêtre  Paramètres  ­>  onglet  Port  série,  configurez  les  paramètres  comme  indiqué  dans  la  figure  7­15  |  Terminal  

S  ­  Outils  ­>  Paramètres  ­>  Menu  Port  série.  Pour  connaître  le  numéro  de  port  série,  consultez  l'ÉTAPE  1  –  Paramètres  de  

l'interface  RS­232  sur  votre  PC :

Quittez  tous  les  programmes  en  cours  d’exécution  sur  votre  ordinateur  et  DÉSACTIVEZ/DÉSACTIVEZ  tout  logiciel  antivirus ;

10000;­  Délai  d'expiration  de  la  commande  (ms)

ÉTAPE  3  –  Utilisation  du  logiciel  Terminal  S  pour  la  mise  à  jour  du  micrologiciel

•

•

•
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Figure  7­14  |  Terminal  S  ­  Outils  ­>  Paramètres  ­>  Menu  général

Figure  7­15  |  Terminal  S  ­  Outils  ­>  Paramètres  ­>  Menu  Port  série

Figure  7­15  |  Terminal  S  ­  Outils  ­>  Paramètres  ­>  Menu  Port  série

Figure  7­14  |  Terminal  S  ­  Outils  ­>  Paramètres  ­>  Menu  général
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•  Une  fois  connecté,  cliquez  sur  l'  icône  de  téléchargement/téléchargement  du  micrologiciel  (deux  flèches  opposées)

directions)  ou  utilisez  Appareil  ­>  Téléchargement/téléchargement  du  micrologiciel  depuis  la  barre  de  menu  pour  activer  le
Chargeur  de  démarrage;

Figure  7­17  |  Terminal  S  ­  Téléchargement  du  micrologiciel

prises)  ou  utilisez  Appareil  ­>  Connecter  dans  la  barre  de  menus ;

Figure  7­16  |  Borne  S  ­  Connexion  à  l'amplificateur

Figure  7­16  |  Borne  S  ­  Connexion  à  l'amplificateur

•  Connectez  le  terminal  ACOM  S  à  l'amplificateur  en  cliquant  sur  l'  icône  Connecter  (deux

Figure  7­17  |  Terminal  S  ­  Téléchargement  du  micrologiciel

Lorsque  le  chargeur  de  démarrage  a  été  activé,  des  bips  seront  émis  par  l'amplificateur  et  l'écran  avant  deviendra  

noir.
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•  Ouvrez  la  fenêtre  Paramètres  en  cliquant  sur  l'  icône  Paramètres  (deux  engrenages)  ou  utilisez  Outils  ­>  Paramètres

Paramètres  du  port  série 34800,  8,  Aucun,  1

Figure  7­19  |  Terminal  S  ­  Modification  du  nombre  de  bits  par  seconde

Figure  7­18  |  Terminal  S  ­  Déconnexion

Depuis  la  barre  de  menus.  Dans  la  fenêtre  Paramètres  ­>  onglet  Port  série,  configurez  les  paramètres  comme  indiqué  dans  la  figure  

7­19  |  Terminal  S  ­  Modifier  le  nombre  de  bits  par  seconde :

Figure  7­18  |  Terminal  S  ­  Déconnexion

Cliquez  sur  l'  icône  Déconnecter  (deux  prises  séparées)  ou  utilisez  Appareil  ­>  Déconnecter  dans  la  barre  de  menu  pour  vous  

déconnecter  de  l'amplificateur.

­

(modifier  uniquement  le  paramètre  « Bits  par  seconde ») ;

Figure  7­19  |  Terminal  S  ­  Modification  du  nombre  de  bits  par  seconde

•
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•  Une  fois  connecté,  cliquez  sur  l'  icône  de  téléchargement/téléchargement  du  micrologiciel  (deux  flèches  opposées)

(directives)  ou  utilisez  Appareil  ­>  Téléchargement  du  micrologiciel  dans  la  barre  de  menus  pour  activer  le  chargeur  de  démarrage.  

Un  menu  de  démarrage  apparaîtra  dans  la  zone  de  texte,  comme  illustré  ci­dessous ;

Figure  7­21  |  Terminal  S  ­  Menu  du  chargeur  de  démarrage

Figure  7­21  |  Terminal  S  ­  Menu  du  chargeur  de  démarrage

Appareil  ­>  Connecter  depuis  la  barre  de  menu ;

Figure  7­20  |  Terminal  S  ­  Reconnexion

Figure  7­20  |  Terminal  S  ­  Reconnexion

•  Reconnectez­vous  à  l'amplificateur  en  cliquant  sur  l'  icône  Connecter  (deux  prises  connectées)  ou  utilisez
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Une  nouvelle  boîte  de  dialogue  s'ouvre,  vous  demandant  le  nom  et  l'emplacement  du  nouveau  fichier  du  firmware.  Ouvrez  le  dossier  

contenant  le  fichier  (*.dat),  sélectionnez­le  et  cliquez  sur  le  bouton  « Télécharger »  (nous  supposons  que  vous  avez  téléchargé  le  

dernier  firmware  depuis  www.acom­bg.com  et  que  vous  l'avez  décompressé  sur  votre  PC).

Figure  7­22  |  Terminal  S  ­  Téléchargement  du  micrologiciel

Le  processus  de  téléchargement  du  micrologiciel  peut  prendre  environ  3  à  6  minutes.

Appuyez  sur  la  lettre  Y  de  votre  clavier  pour  répondre  à  la  question  qui  apparaît :

Figure  7­22  |  Terminal  S  ­  Téléchargement  du  micrologiciel

LE  MICROLOGICIEL  ACTUEL  SERA  EFFACÉ !  ÊTES­VOUS  SÛR  (N/N) ?

Appuyez  sur  la  lettre  U  de  votre  clavier  pour  activer  le  processus  de  téléchargement  du  micrologiciel.

Pendant  le  processus  de  mise  à  jour  du  micrologiciel,  les  paramètres  de  l'amplificateur  de  l'utilisateur  sont  conservés  et  sont  
disponibles  dans  la  nouvelle  version  du  micrologiciel.
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Une  nouvelle  boîte  de  dialogue  s'ouvre,  vous  invitant  à  saisir  un  nom  et  un  emplacement  pour  le  nouveau  fichier  de  sauvegarde.  

Cliquez  sur  le  bouton  Télécharger  pour  lancer  le  processus.

Le  processus  de  sauvegarde  du  micrologiciel  peut  prendre  environ  3  à  6  minutes.

Figure  7­23  |  Terminal  S  ­  Processus  de  sauvegarde  du  micrologiciel

Appuyez  sur  la  lettre  B  de  votre  clavier  pour  activer  le  processus  de  sauvegarde  du  micrologiciel.

Figure  7­23  |  Terminal  S  ­  Processus  de  sauvegarde  du  micrologiciel

•
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Appuyez  et  maintenez  enfoncé  pendant  1  à  2  secondes  le  bouton  POWER  pour  redémarrer  l'amplificateur  et  passer  en  mode  veille

Vous  pouvez  vérifier  la  version  actuelle  du  firmware  dans  le  menu  FAULT  LOG  de  l'amplificateur  (voir  Section

•  Appuyez  sur  le  bouton  POWER  pour  éteindre  l’amplificateur  (retour  au  mode  STANDBY  basse  consommation) ;

Débranchez  la  fiche  secteur  de  la  prise ;

Figure  7­24  |  Terminal  S  ­  Processus  de  sauvegarde  du  micrologiciel

mode.

Figure  7­24  |  Terminal  S  ­  Processus  de  sortie

Appuyez  sur  la  lettre  E  de  votre  clavier  pour  quitter  le  processus.  Cliquez  sur  l'  icône  Déconnecter  (deux  prises  séparées)  ou  utilisez  

Appareil  ­>  Déconnecter  dans  la  barre  de  menus  pour  vous  déconnecter  de  l'amplificateur.  Cliquez  sur  Fichier  ­>  Quitter  dans  la  

barre  de  menus  pour  fermer  le  Terminal  S.

•  Éteignez  l'amplificateur  via  l'interrupteur  à  bascule  d'alimentation  principal  (voir  Figure  2­4  |  Panneau  arrière  ­

Connexions,  Pos.  1) ;  Assurez­vous  que  l'interrupteur  à  bascule  d'alimentation  principal  est  en  position  OFF ;

Suivez  les  instructions  de  la  section  2.4  Connexions  pour  reconnecter  l’amplificateur  à  votre  station.

Débranchez  le  convertisseur  « USB  vers  RS­232 »  ou  le  câble  RS­232 ;•

•

Page  78  sur  94  |  Section  ENTRETIEN

•

•

•

Manuel  d'utilisation  |  ACOM  1200S  |  Amplificateur  de  puissance  linéaire  1,8­54  MHz

Août  2024

5.5  Menu  JOURNAL  DES  PANNES) ;

Machine Translated by Google



Paramètre  de  temporisation  de  latence  tel  que  décrit  dans  la  section  7.5.3  Mises  à  jour  du  micrologiciel

(ÉTAPE  1  –  Paramètres  de  l’interface  RS­232  sur  votre  PC) ;

Figure  7­25  |  Terminal  S  ­  Erreur  de  délai  d'attente

Figure  7­25  |  Terminal  S  ­  Erreur  de  délai  d'attente

Parfois,  la  procédure  de  mise  à  jour/sauvegarde  du  micrologiciel  échoue.

Si  vous  voyez  un  message  d'erreur  lié  au  délai  d'attente,  veuillez  vérifier :

A.  Erreur  de  délai  d'attente  lors  de  l'utilisation  du  logiciel  Terminal  S

7.5.4.  Dépannage

Si  vous  utilisez  un  PC  avec  un  port  RS­232  intégré :

­  Vérifiez  les  paramètres  du  tampon  de  réception/transit  comme  décrit  dans  la  section  7.5.3  Mises  à  jour  du  micrologiciel  (ÉTAPE  1  

–  Paramètres  de  l'interface  RS­232  sur  votre  PC) ;

­  Vérifiez  le  câble  de  connexion  utilisé.  Voir  le  tableau  7­2  |  Câblage  du  câble  de  connexion  RS­232  pour  plus  d'informations.

câblage  correct;

•  Paramètre  de  délai  d'expiration  de  commande  tel  que  décrit  dans  la  section  7.5.3  Mises  à  jour  du  micrologiciel

(ÉTAPE  3  –  Utilisation  du  logiciel  Terminal  S  pour  la  mise  à  jour  du  micrologiciel).

•
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Figure  7­26  |  Gestionnaire  de  périphériques  Windows  ­  Charger  VCP

Vous  trouverez  ci­dessous  les  paramètres  recommandés  (VCP  =  Virtual  Com  Port) :

Les  autres  raisons  possibles  de  l'erreur  de  délai  d'attente  pourraient  être,  par  exemple :

Figure  7­26  |  Gestionnaire  de  périphériques  Windows  ­  Charger  VCP

•  Gestionnaire  de  périphériques  Windows  ­>  Propriétés  du  convertisseur  série  USB  ­>  Avancé
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Figure  7­27  |  Gestionnaire  de  périphériques  Windows  ­  Gestion  de  l'alimentation

Vous  trouverez  ci­dessous  les  paramètres  recommandés :

Figure  7­27  |  Gestionnaire  de  périphériques  Windows  ­  Gestion  de  l'alimentation
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Figure  7­28  |  Panneau  de  configuration  Windows  ­  Mode  de  gestion  de  l'alimentation

Vous  trouverez  ci­dessous  les  paramètres  recommandés :

Figure  7­28  |  Panneau  de  configuration  Windows  ­  Mode  de  gestion  de  l'alimentation
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­

appuyez  sur  les  boutons  du  Terminal  S.

prises  connectées) ;

▪  Démarrez  le  Terminal  S  et  continuez  la  procédure  de  mise  à  jour  du  firmware  depuis  le  début ;

Cliquez  sur  Fichier  ­>  Quitter  dans  la  barre  de  menu  pour  fermer  le  Terminal  S ;

­  Remettre  l'amplificateur  sous  tension ;

Si,  pour  une  raison  quelconque  (principalement  une  erreur  humaine),  le  processus  de  mise  à  jour/sauvegarde  du  micrologiciel  est  interrompu,  

les  scénarios  suivants  sont  possibles :

B.

­

­

▪  Continuez  la  procédure  de  mise  à  jour  du  micrologiciel  comme  d’habitude.

o  Si  l'amplificateur  démarre  normalement  et  passe  en  mode  STB,  alors :

Cliquez  sur  Fichier  ­>  Quitter  dans  la  barre  de  menu  pour  fermer  le  Terminal  S ;­

Solution:

o  Si  l'amplificateur  démarre  avec  un  écran  noir  (mode  BOOTLOADER),  démarrez  le  Terminal  S  et  modifiez  les  

paramètres  du  port  série  sur  38400,  8,  Aucun,  1 ;

Démarrer  le  terminal  S ;

•  L'amplificateur  est  en  mode  STANDBY  (le  moniteur  affiche  l'interface  utilisateur)  mais  rien  ne  se  passe  lorsque  vous  appuyez  sur  les  

boutons  du  Terminal  S.

­ Cliquez  sur  l'  icône  Déconnecter  (deux  prises  séparées)  pour  vous  déconnecter  de  l'amplificateur ;

▪  Connectez­vous  à  l'amplificateur  en  cliquant  sur  l'  icône  Connecter  (deux

Solution:

Démarrez  la  procédure  de  mise  à  jour  du  micrologiciel  depuis  le  début.

­  Appuyez  et  maintenez  enfoncé  pendant  1  à  2  secondes  le  bouton  POWER  pour  éteindre  l'amplificateur ;

­  Appuyez  et  maintenez  enfoncé  pendant  1  à  2  secondes  le  bouton  POWER  pour  éteindre  l'amplificateur ;

Si  le  problème  persiste,  contactez  votre  concessionnaire  (voir  Section  1.9  Assistance  au  propriétaire).

▪  Cliquez  sur  l'  icône  de  téléchargement  du  micrologiciel  (deux  flèches  dans  des  directions  opposées)  

pour  activer  le  chargeur  de  démarrage.  Un  menu  du  chargeur  de  démarrage  devrait  maintenant  

apparaître  dans  la  zone  de  texte ;

­

­  Remettre  l'amplificateur  sous  tension ;

Cliquez  sur  l'  icône  Déconnecter  (deux  prises  séparées)  pour  vous  déconnecter  de  l'amplificateur ;

•  L'écran  de  l'amplificateur  est  noir/pas  d'image  (mode  BOOTLOADER)  mais  rien  ne  se  passe  lorsque  vous
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(bande  40  m)7 000  ­  7 300  MHz

5,020  ­  5,455  MHz (bande  60  m)*

c)  Distorsions  d'intermodulation  (IM3)

(bande  80  m)

50  000  ­  54  000  MHz  (bande  de  6  m)*

Vous  devrez  réduire  la  puissance  de  sortie  à  environ  500  W  afin  de  maintenir  la  consommation  de  courant  secteur  en  

dessous  de  10  A  si  l'amplificateur  fonctionne  à  une  tension  d'alimentation  secteur  inférieure  à  200  VCA.

(bande  160  m)

28  000  ­  29  700  MHz  (bande  de  10  m)

24,890  ­  24,990  MHz  (bande  de  12  m)

3.500  ­  4.000  MHz

•  1000  W  ±0,5  dB,  PEP  ou  porteuse  continue,  sans  limitation  de  mode ;

b)  Puissance  de  sortie  nominale

1 800  ­  2 000  MHz

21  000  ­  21  450  MHz  (bande  de  15  m)

18,068  ­  18,168  MHz  (bande  de  17  m)

a)  Couverture  de  fréquence  standard

Dans  certains  cas,  des  extensions  ou  des  modifications  de  la  couverture  de  fréquences  peuvent  être  envisagées,  mais  

elles  doivent  être  convenues  avant  la  commande.  Dans  tous  les  cas,  cela  n'engage  pas  le  producteur  et  ne  saurait  être  

contraire  aux  lois  et  réglementations  locales.

d)  Suppression  des  émissions  harmoniques  et  parasites

8.1.  Paramètres

14  000  ­  14  350  MHz  (bande  de  20  m)

Mieux  que  60  dB  (65  dB  généralement) ;

Veuillez  vous  référer  aux  plans  de  bande  régionaux  et  aux  lois  applicables  pour  connaître  les  allocations  et  les  
limitations  spécifiques.

10,100  ­  10,150  MHz  (bande  de  30  m)

Mieux  que  31  dB  en  dessous  du  PEP  nominal ;•

AVIS

8.  CARACTÉRISTIQUES

•

*
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•  ROS  du  chemin  de  dérivation  RF  ­  inférieur  à  1,1,  1,8­54  MHz ;

•  100­240  VCA  (alimentation  à  découpage),  50­60  Hz,  monophasé ;  •  En  dessous  de  200  VCA,  

la  puissance  de  sortie  est  réduite  à  500  W ;

•

•  Conforme  aux  exigences  de  sécurité  et  de  compatibilité  électromagnétique  CE,  ainsi  qu'aux

•

•  TOS  acceptable  à  la  charge  de  sortie  (l'antenne) :  jusqu'à  3  avec  une  puissance  proportionnelle

•  Valeur  nominale :  50  Ohm  asymétrique,  connecteurs  de  type  UHF  (SO­239) ;
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•  LxPxH :  372x418x162  mm,  16,0  kg  (14,7x16,5x6,4  pouces,  35,3  lb) ;
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•  14  dB  ±1  dB  (typiquement  40  W  pour  une  puissance  de  sortie  de  1 000  W) ;

­  Courant  en  circuit  fermé  circulant  vers  la  sortie  de  modulation  de  l'émetteur­récepteur  ­  jusqu'à  6  mA ;

­  Tension  appliquée  à  la  sortie  de  modulation  de  l'émetteur­récepteur  ­  jusqu'à  +12  V ;

f)  Gain  de  puissance  RF

réduction  et  jusqu'à  1,5  pour  une  puissance  de  sortie  maximale ;

j)  Contrôle  réception /  transmission  •  Entrée  

KEY­IN  ­  Prise  phono  RCA.

l)  Dimensions  et  poids  (en  fonctionnement,  hors  câbles  connectés  et  barre  de  pied  inclinable  ouverte)

Moins  de  1  VA ;

les  réglementations  de  la  Commission  fédérale  des  communications  des  États­Unis  (FCC) ;

i)  Consommation  électrique  du  secteur  en  mode  basse  consommation  (attente)

h)  Consommation  électrique  du  secteur  à  pleine  puissance  de  sortie  •  Facteur  

de  puissance  de  0,95  ou  plus ;  •  Jusqu'à  2100  VA  

à  la  puissance  de  sortie  nominale  d'une  alimentation  secteur  de  200/240  VCA ;  •  Jusqu'à  1100  VA  

à  une  puissance  de  sortie  de  500  W  d'une  alimentation  secteur  de  100/120  VCA ;

Circuit  d'entrée :  large  bande,  ROS  inférieur  à  1,2  (1,1  typiquement),  plage  continue  de  1,8  à  54  MHz  sans  réaccord  ni  

commutation ;

k)  Sécurité  et  compatibilité  électromagnétique

­  Résistance  de  sortie :  pas  plus  de  120  Ohm ;  ­  Tension  maximale  

admissible  en  circuit  ouvert  provenant  de  la  connexion  de  l'émetteur­récepteur :  +50  V ;  ­  Courant  maximal  admissible  en  circuit  

fermé  circulant  par  l'émetteur­récepteur :  20  mA ;  •  Temps  mort  minimum,  nécessaire  pour  une  commutation  sûre  

de  l'amplificateur  de  la  réception  à  la  transmission :  10  ms  entre  la  demande  de  transmission  sur  l'  entrée  KEY­IN  et  la  commande  RF  sur  

la  prise  RF  INPUT .

•  Sortie  KEY­OUT  ­  drain  ouvert,  prise  phono  RCA.

g)  Tension  d'alimentation  secteur

e)  Impédances  d'entrée  et  de  sortie
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•  Altitude  au­dessus  du  niveau  de  la  mer :  jusqu'à  3  050  m  (10  000  pi)  sans  détérioration  de  la  puissance.
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8.2.  Fonctions

a)  Contrôle  de  fréquence  directement  par  CAT  depuis  l'émetteur­récepteur

b)  Contrôle  à  distance  via  le  dispositif  de  contrôle  à  distance  Ethernet  ACOM  eBox  ou  via  l'interface  RS­232

c)  Mise  sous  tension  à  distance  par  lignes  DSR/DTR  et  CTS/RTS  sur  le  port  RS­232  ou  par  ACOM  eBox

•  Plage  de  température :  ­10  à  +40  degrés  Celsius  (14  oo  F) ;

Humidité  relative  de  l'air :  jusqu'à  95  %  à  35  degrés  Celsius  (95  o  F) ;

F  à  104

m)  Environnements  d'exploitation

Dispositif  de  contrôle  à  distance  Ethernet

d)  MISE  SOUS  TENSION /  ARRÊT  à  distance  par  impulsion  de  tension  continue  ou  tension  continue  sur  l'entrée  ON_RMT  du  

port  CAT/AUX.
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AVERTISSEMENT

www.fcc.gov/oet/ea/fccid.
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Le  numéro  d'identification  FCC  peut  être  vérifié  à  l'adresse

Pour  vous  conformer  au  titre  47  partie  97.13(C)  du  CFR  et  aux  directives  et  limites  d'exposition  humaine  aux  champs  

électromagnétiques  RF  adoptées  par  la  FCC,  vous  devez  évaluer  vos  installations  de  station  radio  comme  décrit  dans  le  BULLETIN  

OET  65  plus  SUPPLÉMENT  B  ­  Informations  supplémentaires  pour  les  stations  de  radio  amateur.

Cette  unité  (amplificateur  ACOM  1200S)  est  conforme  aux  limites  d'exposition  RF  de  la  FCC  pour  un  environnement  non  
contrôlé.

Le  numéro  d'identification  FCC  explique  que  le  produit  ACOM  du  marché  est  conforme  

aux  réglementations  de  la  Federal  Communications  Commission  (FCC)  des  États­Unis.

ID  FCC :  2AJXZ1200S

En  utilisant  l'amplificateur  ACOM  1200S,  les  antennes  doivent  être  utilisées  à  une  certaine  distance  minimale  entre  le  

radiateur  et  le  corps  de  toute  personne.

Numéro  d'identification  FCC

c)  Informations  sur  l'exposition  aux  RF

b)  Règlements  de  la  Commission  fédérale  des  communications  des  États­Unis  (FCC)

Ce  symbole  explique  que  le  produit  ACOM  marqué  « CE »  répond  aux  exigences  essentielles  

de  la  directive  sur  les  équipements  radio,  2014/53/UE,  et  à  la  directive  sur  la  restriction  de  

l'utilisation  de  certaines  substances  dangereuses  dans  les  équipements  électriques  et  

électroniques,  2011/65/UE.

­  Un  code  produit  d'équipement  (par  exemple  1200S).

­  Un  code  de  bénéficiaire  (par  exemple  2AJXZ),  et

Marquage  CE  (Conformité  Européenne)

a)  Conformité  européenne

Les  numéros  d'identification  FCC  se  composent  de  deux  éléments :

8.3.  Exigences  réglementaires

Machine Translated by Google

http://www.fcc.gov/oet/ea/fccid


Page  88  sur  94  |  S  ection  SPÉCIFICATIONS Août  2024

•  https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65.pdf;
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•  https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65b.pdf.

Le  BULLETIN  OET  65  plus  SUPPLÉMENT  B  est  disponible  à  l'adresse  suivante :

En  plus  des  directives  ci­dessus,  veuillez  consulter  la  section  3.6.f)  Élimination  des  problèmes  de  compatibilité  électromagnétique  (CEM).
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•  LxPxH :  environ  620x580x380  mm,  20,0  kg  (24,5x22,9x15,0  pouces,  44,1  lb).
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8.4.2.  Dimensions  et  poids  à  l'expédition

Veuillez  contacter  ACOM  (voir  1.9  Assistance  au  propriétaire)  pour  les  détails  d'expédition.

Figure  8­1  |  Boîte  en  carton  d'emballage

8.4.1.  Environnement  de  stockage

•  Plage  de  température :  ­40  à  +70  degrés  Celsius  (­40  o  F  à  158  o  F) ;  Humidité :  jusqu'à  

75  %  à  +35  degrés  Celsius  (95  o  F).

L'amplificateur  peut  être  conservé  emballé  dans  un  endroit  sec,  ventilé  et  non  chauffé  (sans  substances  chimiquement  actives  telles  que  des  

acides  ou  des  alcalis)  dans  les  plages  environnementales  suivantes :

8.4.  Stockage  et  expédition

8.4.3.  Transport

Tous  les  types  de  transport  peuvent  être  utilisés,  y  compris  le  stockage  dans  un  compartiment  à  bagages  d'avion  jusqu'à  12  000  mètres  (40  

000  pieds)  au­dessus  du  niveau  de  la  mer.

Figure  8­1  |  Boîte  en  carton  d'emballage
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AVIS

AVIS

DANGER

•  L’amplificateur  est  maintenant  prêt  à  être  expédié.
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•  Scellez  le  carton  de  l’amplificateur  avec  du  ruban  adhésif  résistant  de  2  pouces  de  large ;

•

•

•  Emballez  l'amplificateur  dans  son  carton  d'origine.  Veuillez  suivre  les  instructions  de  la  section
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Si  vous  transportez  votre  appareil  pour  diagnostic  et  réparation,  certains  câbles  ou  accessoires  ne  seront  peut­être  pas  

nécessaires.  Veuillez  consulter  votre  revendeur  au  préalable.

Retirez  la  connexion  GND  en  dernier  (voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,  Pos.  (a))  et  attendez  30  minutes  par  

mesure  de  sécurité.

Il  est  de  la  seule  responsabilité  du  client  de  s'assurer  que  le  commutateur  et  tous  les  accessoires  sont  correctement  emballés  

pour  éviter  tout  dommage  pendant  le  transport.

Votre  revendeur  peut  avoir  une  exigence  d'expédition  spécifique,  par  exemple  une  adresse  de  livraison  différente.

Avant  d’expédier  l’amplificateur,  vous  devez  d’abord  contacter  votre  revendeur  local.

•  Débranchez  tous  les  câbles  (sauf  la  connexion  GND )  du  panneau  arrière  de  l'amplificateur ;

•  Ne  déconnectez  pas  la  connexion  GND ;

Enfin,  le  cerclage  extérieur  doit  être  ajouté  sur  le  carton  de  l'amplificateur.  Des  bandes  plastiques  ou  métalliques  peuvent  être  utilisées.

S'il  est  nécessaire  d'expédier  l'amplificateur,  utilisez  l'emballage  d'origine  comme  décrit  ci­dessous.

Retirez  la  fiche  secteur  de  l’amplificateur  de  la  prise ;

Pos.  1) ;  Assurez­vous  que  l'interrupteur  à  bascule  d'alimentation  principal  est  en  position  OFF ;

Cette  section  du  document  contient  les  informations  générales  sur  l'emballage  et  l'expédition  d'un  amplificateur  à  des  fins  de  diagnostic  et  de  réparation.

•  Éteignez  l'amplificateur  via  l'interrupteur  à  bascule  d'alimentation  principal  (voir  Figure  2­4  |  Panneau  arrière  ­  Connexions,

2.1  Déballage  et  inspection  initiale  mais  dans  l’ordre  inverse ;

Préparez  l'amplificateur  pour  l'expédition  comme  décrit  ci­dessous :

8.4.4.  Retour  au  prestataire  de  services
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Les  produits  ACOM  ne  peuvent  pas  être  jetés  avec  les  déchets  ménagers.

Déchets  électriques

Ce  symbole  (poubelle  à  roulettes  barrée)  explique  que  vous  ne  devez  pas  jeter  l'appareil  

électrique  dans  les  déchets  ménagers.

Contactez  votre  autorité  locale  pour  obtenir  des  informations  sur  la  localisation  d'une  installation  de  recyclage  la  plus  proche  de  chez  vous.

Pour  des  instructions  d'expédition  alternatives,  veuillez  contacter  votre  revendeur  local.

Les  informations  contenues  dans  cette  section  s’appliquent  aux  pays  qui  ont  adopté  des  systèmes  de  collecte  séparée  

des  déchets.

8.5.  Informations  sur  l'élimination  et  le  recyclage  des  anciens  équipements  électriques  et  électroniques

L'assurance  expédition  de  base  est  souscrite  par  le  client  lors  de  l'envoi  d'un  amplificateur.  Vous  pouvez  vérifier  le  

montant  couvert  par  le  transporteur  sur  son  site  web.  Si  vous  expédiez  l'amplificateur,  une  couverture  complète/

améliorée  est  proposée  en  option.

Ce  symbole  (trois  flèches  vertes  formant  un  triangle  avec  une  prise  électrique  au  centre)  

signifie  que,  conformément  aux  lois  et  réglementations  locales,  ce  produit  doit  être  

envoyé  au  recyclage.

Les  anciens  équipements  électriques  et  électroniques  ainsi  que  les  batteries  doivent  être  recyclés  dans  une  installation  capable  de  gérer  ces  

articles  et  leurs  déchets.

L’élimination  finale  de  ce  produit  doit  être  effectuée  conformément  à  toutes  les  lois  et  réglementations  nationales.

Déchets  électriques

Un  recyclage  et  une  élimination  appropriés  des  déchets  contribueront  à  préserver  les  ressources  tout  en  prévenant  les  effets  néfastes  sur  notre  
santé  et  l’environnement.
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Les  dernières  versions  de  nos  manuels  d'utilisation  sont  disponibles  sur  

www.acom­bg.com

Ce  manuel  est  principalement  destiné  à  la  distribution  électronique.

Si  vous  l'avez  sur  papier  et  que  vous  n'en  avez  plus  besoin,  s'il  vous  plaît,  recyclez­le !
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Sujet  à  changement  sans  préavis.  I  Imprimé  en  Bulgarie.
Tous  droits  réservés.  Conception  et  contenu  par  ACOM  Ltd.

ACOM  et  le  logo  ACOM  sont  des  marques  déposées  d'ACOM  Ltd.  dans  de  nombreux  pays,  dont  l'UE  et  
les  États­Unis.  Les  images  utilisées  sont  données  à  titre  indicatif  uniquement.

Manuel  d'utilisation  de  l'ACOM  1200S  I  Quatrième  édition,  révision  03  I  Août  2024.

www.acom­bg.com

Coordonnées  GPS :  42.748616о  |  23.209801о

Bulgarie  |  Bozhurishte  2227  
Parc  industriel  de  Sofia­Bozhurishte  |  6,  rue  Valéri  Petrov.
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